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1 Introduction 

The Oasys Ltd LS-DYNA Environment 21.0 suite, dated May 2024, is a full release which 
supersedes all previous releases. 

This document lists the enhancements that have been made during development, and the bugs 
that have been fixed (since 20.1). Each ‘Case ID’ referred to in these lists is unique and should 
be cited if more information or clarification are required. 

 

1.1 Compatibility with LS-DYNA releases 

The 21.0 release has been used and tested with LS-DYNA version R15 and the current 
development version. It supports all the keywords in volumes I, II and III of the released R14.0 
User’s Manual. Some of the new keywords in the released R15 User’s Manual are also 
supported.  

LS-DYNA R11.0 is the default keyword output format from PRIMER. (However, output may be 
generated for later releases of LS-DYNA.) 

 

1.2 Hardware platforms supported 

The complete Oasys Ltd LS-DYNA Environment 21.0 is available on the following platforms: 

Windows  Windows 10/11 64 bit 

Linux RedHat Enterprise 8.x 64 bit 

The RedHat Enterprise 8.x build has been released on the website for Linux as this has been 
found to run on all the machines we have tested (RHEL 8, SuSE 15.2). 

If you require a different Linux build, please contact Oasys Ltd. 

Windows builds have been tested on Windows 10 and Windows 11. The software may run on 
Windows 8.1, but this is untested. It will not run on Windows versions prior to that because of 
changes in the way Microsoft configure displays. 

 

1.3 Graphics hardware supported 

The default graphics protocol used on all platforms in the table above is OpenGL, which gives 
good quality 3D performance on a wide range of hardware. 

‘Legacy’ X-Windows (2D only) graphics drivers remain in PRIMER on Linux platforms only, 
since these are used by a small minority of clients who display over a network of mixed machine 
types. However, this X driver is not maintained or updated and will give poor performance, so it 
should only be used as a last resort.  There are much better ‘thin wire’ graphics solutions 
available today, and Oasys Ltd can give advice about these on request. 
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1.4 Licensing 

This latest version of the software will only use the LM-X licensing platform to provide an 
increased level of license security.  

To ensure you’re ready to enjoy all the great features Oasys Suite 21.0 will bring, we recommend 
you update all your Oasys Suite license servers and files as soon as possible.  

Action to take  

If you’re using a floating network license you will need to install the LM-X license server 
software (version 5.5.7). The software and supporting documentation are available to download 
from our website and are also included in our installation packages.  

Backwards compatibility  

The Oasys Suite 21.0 LM-X license file and license daemons are backwards compatible for all 
currently supported versions of Oasys Suite. This means that any existing 20.x, 19.x and 18.x 
software will continue to work with new LM-X license files and servers. 
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2 Bugs Fixed 

The enhancements and bug-fixes for each program have been broken down into a series of 
topics.  Within each topic enhancements and bug-fixes are listed by case ID. 

2.1 PRIMER 

Adhesive 

• Case 53066 

The Auto-make adhesive tool was getting stuck when it is unable to process an extruded part. A 

trap has been added to prevent this and the process will now abort. 

Assembly 

• Case 51773 

*SET_PART_TREE creation was previously crashing when there are circular references. This 

issue has been fixed by adding a check for circular references in *SET_PART_TREE. 

Attached 

• Case 53040 

Previously, the Find Attached tool was not working for SPR-related keywords. The Find 

Attached tool has now been corrected to work with constrained SPR, SPR2 and 

interpolation_spotweld (SPR3). 

• Case 51494 

Previously, we could not access *CONSTRAINED sub-menu toggles via the JavaScript API 

Attached Class. This issue has been fixed. JavaScript API support for constrained types within 

the Attached tool is now enhanced. 

Belts 

• Case 52964 

Changing the units of a model containing a belt definition from metre to millimetre units could 

cause a crash if the belt were subsequently (re)fitted. This would only occur if the belt had non-

standard element lengths for one or more of its path segments, and then only if the belt had a lot 

of rows of elements. 

 

This was caused by a failure to scale optional per-segment belt lengths resulting in this case in 

1000x as many elements in the affected stretches of the belt which, in turn, caused some internal 

overflows. Now fixed. 

• Case 52737 

Previously, seatbelt advanced point handles are not shown after reading belt path points from a 

csv file. This has been fixed. Seatbelt advanced point handles will now remain active after 

reading belt path points from a csv file. 
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• Case 52683 

Seatbelt X-section ID and names are lost when the belt is refitted. This has been fixed. Auto 

refitting a seatbelt will now reuse the X-section ID of the old meshed belt, and there is now an 

option to keep X-section names during a refit. 

• Case 52587 

Previously for Shoulder to Pelvis seatbelts, X-Section and Quick Adjust features only worked 

with belts going from shoulder to the Pelvis but not in reverse. This has now been fixed by 

adding a Belt direction radio button to the Explicit Slipring panel. 

A Shoulder to Pelvis belt direction means that the seatbelt goes from the shoulder slipring to the 

pelvis buckle and a Pelvis to Shoulder directions means the belt goes in the opposite way. This 

needs to be specified for the Adjust and Create X-Section function. 

• Case 52072 

When a seatbelt is meshed continuously (explicitly) through a slipring, it can pull material from 

one stretch of belt to the next through the slipring. This could lead to a row of elements in the 

vicinity of the slipring getting stretched far too much. 

 

The reason for this is that the mathematical model of the belt was not originally set up to 

consider belt material flowing from one stretch to another. In the older logic, each stretch was 

delimited by a slipring element and the belt within that stretch only ever got shorter. 

 

The issue is now fixed by changing the model so that flow between stretches works correctly. 

• Case 52070 

Previously after slipring rotation, old initial path points were not updated to account for the 

rotation. This meant that the belt no longer goes through the slipring slot due to its rotation. This 

has now been fixed. 

Initial belt path points around sliprings now have their coordinates updated after the belt path 

was accepted in the main panel. This allows the initial path points to remain positioned within 

the slipring slots after the sliprings were rotated. 

• Case 51583 

Previously after using the explicit slipring ‘Adjust’ option, the belt length between the newly 

generated point behind the slipring and the one after would not update when you changed the 

belt length for the whole belt. This has been fixed. 

• Case 51574 

When loading a predefined seatbelt model, the ‘Seatbelt Mesh Density’ in ‘Fitting options’ panel 

is set to ‘Coarse (default)’ even though the belt length and number of rows are not set to the 

coarse values (length=10 and #rows=5). 

This has been fixed by adding a new ‘Custom’ mode for the seatbelt mesh density in the ‘Fitting 

options’ panel that gets automatically selected if the related properties (Max curve angle, belt 

length and #rows) do not match any of the available modes. If they do match a specific mode, 

the matching mode will be automatically selected instead. 

• Case 51161 

For seatbelt fitting, we have fixed a bug that was causing the stored belt path points to be lost if 

the input model has some points defined but an empty structure definition and the ‘Fit’ panel is 
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accessed before adding entities to the structure. The ‘Fit’ panel (and following steps) can now 

only be accessed if the structure definition is not null. 

Boundary 

• Case 53014 

Boundary prescribed motion animation has been corrected to transfer motion silently to rigid 

parts or nodal rigid bodies when the nodes of deformable parts attached to them have prescribed 

motion. Additionally, the centre of rotation when defined by VID (DOF = +/-8) has been 

corrected. 

Checking 

• Case 53879 

Excessively slow structural check on node of *LOAD_NODE has been fixed. 

• Case 53824 

Previously, the PRIMER Check tool detected an incompatible material type error if a beam 

element with ELFORM=1 uses thermal material *MAT_T01 or *MAT_T11-15. This has been 

fixed. Errors are no longer reported for beam parts which use thermal materials *MAT_T01 and 

*MAT_T11-15. 

• Case 53256 

The first field in card 2 of *EM_DATABASE_ELOUT and *EM_DATABASE_NODOUT were 

referring to an *ELEMENT_SOLID and a *MESH_NODE respectively. This is incorrect. This 

issue is now fixed and the field correctly refers to a *SET_SOLID and a *SET_NODE 

respectively in PRIMER 21.0. 

• Case 52546 

Previously, Model Check could crash while checking contacts if a tied contact had no content on 

side B in a big model. This is an internal error caused by presuming that both sides of the contact 

would be populated. Issue is now fixed. 

• Case 52483 

*DEFINE_DE_INJECTION uses a latent node set ID to reference a set that LS-DYNA will 

create during the analysis. This set was wrongly reported as an error by model check. This issue 

is now fixed. 

• Case 52062 

Fixed a bug that caused PRIMER to issue error messages for 

*CONTROL_DISCRETE_ELEMENT and *DEFINE_DE_BY_PART keywords, when the 

fields ‘lnorm’ and ‘lshear’ on optional cards were not defined. 

Corrected the writing and reading of optional cards in *CONTROL_DISCRETE_ELEMENT 

and *DEFINE_DE_BY_PART to follow the keyword manual. 

• Case 51541 

The fields LCID on *LOAD_NODE, LCID on *LOAD_MOTION_NODE, and LCID, LCIDT 

and LCIDD on *LOAD_MOVING_PRESSURE can refer to functions (*DEFINE_FUNCTION) 

as well as loadcurves. PRIMER would previously not permit these fields to refer to functions. 

This issue has now been fixed. 
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• Case 46128 

*CONSTRAINED_INTERPOLATION should not contain nodes that are non-structural. 

Previously, there was no such indication in PRIMER. This issue is now fixed. A new check has 

been added to report *CONSTRAINED_INTERPOLATION nodes which are not on structural 

elements. 

Clipboard 

• Case 49080 

The clipboard model from visible function did not consider active cut section in the parent 

model. This has been corrected. 

Coating 

• Case 52486 

A flag used by the Coat panel was not being returned correctly in PRIMER 20.0, meaning 

PRIMER could run out of flagging bits after the panel were opened multiple times. This issue 

has now been fixed. 

Connections 

• Case 53500 

Some newline characters were accidentally added to connection detailed error messages 

previously. They adversely affect writing in the csv format. These newline characters have been 

removed and this issue is now fixed. 

• Case 52423 

For the beam connection during spotweld remeshing, we were getting different outputs if the 

Diameter column is enabled in the connection table or not. It is fixed now. 

• Case 52388 

If a connection rule script was used and the model was deleted and reread, the connection rule 

could fail with an exception. Now fixed. 

• Case 52144 

The process of ‘adding nodes around spotwelds’ in mesh reconstruction options was very slow 

and PRIMER was hanging during this process for a typical vehicle model. This is fixed now. 

The time for this process is significantly reduced and PRIMER does not hang now. 

• Case 52128 

HAZ elements attached to other spotwelds, which were not selected for remeshing, could get 

removed if the mesh reconstruction option is ON during spotweld remeshing. This is fixed now. 

• Case 52127 

The mesh reconstruction stage during spotweld remeshing was slow in large models. This has 

been sped up now and the issue is fixed. 

• Case 52126 

Preserving elements around hole during spotweld remeshing was slow in large models. It is now 

faster and the issue is fixed. 
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• Case 51204 

Previously, the PRIMER connections table did not reflect changes made to connection settings 

using SetSettings() [e.g., c.SetSettings({same_part : true})] in JavaScript. Issue is now fixed. 

• Case 51085 

Models where spotweld beam connections are read with missing diameter value can give 

spurious diameter differences on the connection table although all diameters are displayed 

correctly (i.e. from the section) and clearly match. Issue has been fixed. These values are now set 

to the correct diameter (from the section) before comparing to remove the spurious diffs. 

Constraints 

• Case 46024 

Previously, removing nodes from *CONSTRAINED_INTERPOLATION by screen area 

selection was slow. This has been fixed. 

The node object menu for removing nodes from *CONSTRAINED_INTERPOLATION is now 

filtered to the nodes of the constraint. This means removal by screen area selection of nodes on a 

large model will now work much quicker. 

Contacts 

• Case 51994 

Model check where contacts contained SPH elements were giving spurious error messages about 

invalid type. Now fixed. 

• Case 51216 

Tiebreak contact for MPP has been corrected to take thickness from OPTT (if defined) in 

preference to thickness SST/MST on contact card. It seems, however, that tied contact (not 

tiebreak) still takes SST/MST in preference to OPTT. 

• Case 51086 

The LS-DYNA manual suggest that contact thickness SAST, SBST only applied for shells and 

beams. However, LS-DYNA seems to apply these to tied contact between solids too, so 

PRIMER now includes them. 

• Case 50858 

Contact with setting SOFT = 2 can give spurious penetrations when comparing segments which 

are near normal to one another. The algorithm has been improved. 

Contour 

• Case 52259 

The resizing logic for the Contour LEVELS panel was not quite right. Issue now fixed 

• Case 51876 

In PRIMER 20.0, when you change to a different component when a contour SETTINGS and/or 

LISTINGS panel is open, the panel is not updated to reflect the change in component.  

- This has been fixed so that the SETTINGS and/or LISTINGS panel will be updated when 

the component that is being plotted has changed. 
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• Case 51875 

A bug was discovered in PRIMER for the contouring LEVELS panel (aka. the “Levels & 

Format” panel): 

- The title of some contours (Nodal Mass, SPC (Tr), SPC (Ro), Element Props → 

Formulation, Element Props → #Int Points, etc.) are incorrect in the LEVELS panel. This 

issue has now been fixed. 

• Case 51874 

Some bugs were discovered in PRIMER for discrete contouring, mainly related to the LEVELS 

panel (aka. the ‘Levels & Format’ panel). The following is a list of the issues discovered and 

what has been done to fix them: 

1. There are some special discrete contours in PRIMER like Shell Normals, Load Shell 

Direction, Elem Qual → Fixed criteria, SPC (Tr), SPC (Ro), etc. that have special 

contour colours & non-numeric levels. When the LEVELS panel is opened in these cases, 

what is shown on the panel is completely unrelated to what is being plotted. 

o Since the number of levels, contour values and contour colours for these special 

cases cannot be modified by the LEVELS panel, a new logic has been added to 

issue a warning message and block the opening of this panel when you try to open 

it for these special cases. 

 

2. The disable discrete option is available even when the component that is being plotted 

does not allow discrete contours (aka. no discrete data or more than 13 discrete data → 

discrete contouring cannot be done). This can be confusing. 

o The disable discrete option is now greyed out when discrete contouring cannot be 

done. This has been done for the contour LEVELS panel as well as the contour 

SETTINGS and LISTINGS panels. 

 

3. When the contour LEVELS panel is opened when discrete contouring (e.g., 5 discrete 

levels) is done for the component that is plotted, the number of bands does not switch 

back to the number of bands set (e.g., 13 [set by the oa_pref file or by the LEVELS 

panel]) after changing to do a continuous (non-discrete) plot (e.g., disable discrete or 

change component). This behaviour is inconsistent as compared to when the LEVELS 

panel is not opened. 

o This inconsistency has been fixed. 

 

4. When the LEVELS panel is opened when doing discrete contouring, the contour level 

values shown on the panel are not the actual discrete levels. 

o Since discrete contouring values are determined automatically and cannot be 

modified manually, a decision has been made to show ‘<auto>’ in the contour 

value text boxes when discrete contouring is done. Additionally, new logic has 

been added to evaluate the number of discrete values. 

 

5. The disable discrete option buttons on the contour LEVELS panel is not in sync with the 

option on the contour SETTINGS/ LISTINGS panels. 
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o This has been fixed so that the checkboxes for the disable discrete option are 

always in sync. 

• Case 48189 

While plotting contours, if contour band limits are set and contour option is changed to a 

different option, the limits are remembered the next time you come in to plot the same option but 

are forgotten and reset to for some of these options. 

 

Workflow 1: 

1. Read a model and do a CT/SI plot. 

2. Change the contour option to say Elem Qual → Min Elem Length. 

3. Right click on some intermediate contour band value and select Display + Reset 

contours. 

4. Switch contour option to Elem Qual → Aspect Ratio. 

5. Switch to Timestep. Do the same for contour band here in timestep as well. 

6. Switch back to Elem Qual → Min Elem Length, the contour band limits have been 

remembered. 

7. Switch back to Timestep, here limits have been reset. 

Workflow 2:  

1. Read a model and do a CT/SI plot. 

2. Change the contour option to say Elem Qual → Min Elem Length. 

3. Right click on some intermediate contour band value and select Display + Reset 

contours. 

4. Switch to Timestep. Do the same for contour band here in timestep as well. 

5. Switch back to Elem Qual → Min Elem Length, the contour band limits have been reset. 

This inconsistency (see workflow 1 steps 6 & 7, and workflow 2 step 5) has been fixed now. 

This is also now consistent with the behaviour in D3PLOT. 

Control 

• Case 53654 

Previously when there are no entries on card 2 of *CONTROL_SOLID but the card is written 

because there are entries on card 3, PRIMER will write card 2 with zeros for each field in the 

card. This causes error termination when running LS-DYNA. This issue is now fixed. PRIMER 

will now write a blank line for card 2. 

Crash Test Setup 

• Case 50798 

Previously, the ‘Auto’ mode was available for the Crash Test Setup tool but not available for the 

BATCH Crash Test Setup script. This has been fixed. The BATCH Crash Test Setup script now 

accepts the ‘Auto’ option for the Left, Side, Rear and Front Part Set for contact and alignment. 
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Cut Section 

• Case 53022 

When a cut section defined by the LS-DYNA method was dragged with the middle or right 

mouse button for rotation, the coordinates on the panel did not update correctly. Now fixed. 

Typing in an origin coordinate in the text box did not update the drawing of the plane as 

expected. Now, it retains the normal and edge heads and updates the plane position as expected. 

Issue fixed. 

When there was a linked D3PLOT session, any cut plane defined in PRIMER by the LS-DYNA 

method came across to D3PLOT in the correct location, but with the normal and edge vectors 

scaled to unit length and made orthogonal. Although this defined the correct plane location, it 

was less obvious from the numbers on the panel that the planes were the same. Now, the normal 

head and edge head coordinates are sent across without changing any vector lengths so that the 

numbers are the same in both linked programs. Issue fixed. 

• Case 52928 

When a *DATABASE_CROSS_SECTION is imported on the cut section panel with the LS-

DYNA definition method, the same normal tail, normal head and edge head come across only for 

the _PLANE suffix. With the _SET suffix, *DATABASE_CROSS_SECTION has not got these 

coordinates defined so importing does not make sense. Previously, PRIMER had got corrupted 

coordinates in the cut section definition in such an import and sometimes crashed. Now, there is 

an error message, and the previous cut section definition is retained. Issue has been fixed. 

• Case 52323 

When a thick cut section was defined as second or third direction and the other directions were 

turned off, PRIMER sometimes drew the whole model with faint lines at the boundary of the 

thick cut. When hovering the mouse over the graphics window, the drawing would have 

refreshed to the expected thick cut. Now, PRIMER draws the thick cut correctly regardless of 

whether it is defined as direction 1, 2 or 3. Issue fixed. 

• Case 51973 

The calculation of cut section properties (area, centroid, 2nd moment of area, etc.) was 

mathematically correct but was written in such a way that it was sensitive to the distance of the 

origin of the cut section from the elements being cut. If the section origin was a significant 

distance away, results would become inaccurate due to the use of single precision arithmetic and 

the way the calculations were performed. This has been improved: 

- The logic now uses double (64 bit) arithmetic for most calculations, with key dimensions 

using long double (80 bit) arithmetic. 

- The logic has also been factorised, in effect separating the ‘local’ dimensions within a cut 

element from the ‘distant’ dimension from the plane origin. 

The effect is to make the accuracy of the calculation nearly independent of the distance from the 

origin of the cut plane to the elements being cut, fixing the issue. 

• Case 51423 

When a cut plane intersects a solid or thick shell element, there is a cut polygon on the plane. 

When the face of an element is warped, there are cases of all four edges of a quadrilateral face 

intersecting the plane. In those cases, there was a very distorted cut polygon. This has been fixed. 

Now, the intersection points are connected in the expected order. 
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Damping 

• Case 50414 

Previously, there is no ‘PICK’ option for the *DAMPING_PART_STIFFNESS part/ part set 

drop down. Issue now fixed. A ‘PICK’ option has now been added to the part/ part set drop 

down for the *DAMPING_PART_STIFFNESS keyword. 

• Case 50383 

Previously, the include file was not shown on create/modify panels for *DAMPING cards. This 

issue has been fixed by adding the option to view or change the include file for *DAMPING 

cards from the create/modify panel.  

Database 

• Case 50970 

In PRIMER, the direction of normal vectors of *DATABASE_CROSS_SECTIONs created 

using the Feature Line method is not consistent. This is now fixed. 

• Case 50867 

Previously when using the create/modify panel for *DATABASE_CROSS_SECTIONs, a 

circular cross section (non-zero radius) would not be auto sized when the auto size option was 

activated. Further to this, the auto size option was not available for circular cross sections with a 

negative radius. This has now been corrected. The auto size option now works for circular cross 

sections with either negative or positive radii. 

Deleting 

• Case 52606 

Cleanup removed joints that had node(s) on a deformable part. Whilst this is an error, removing 

the joint is not correct. Issue is now fixed. On the other hand, joints with non-structural node(s) 

will be removed. 

• Case 52317 

The Non_Struct_items ‘Nodes’ switch on the cleanup panel did not control the treatment of non-

structural nodes. If deselected, nodes should be treated as per se structural and neither they nor 

items on them should be offered for cleanup. The bug is not a serious one as types may easily be 

deselected on the subsequent deletion panel. Issue fixed. 

Dummies 

• Case 52517 

Fixed a bug that opened an infinite number of modify *GENERAL_GRAPHICS panels, when 

opened using Tools → Other → Gen Graphics → Modify → Key_In. 

• Case 52416 

Fixed a bug that caused an improper functioning of ‘Quit’ button in LISTING window from the 

modify *GENERAL_GRAPHICS (Tools → Other → Gen Graphics → Modify) panel. 
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• Case 52409 

If a child assembly is defined with NA-NB as rotation axis instead of JSTF, then PRIMER 

throws incorrect error. Fixed this. 

• Case 52150 

In the DUMMY positioning panel, if the DYNA_POSITION nodes are undefined, the dummy 

panel textboxes must highlight these in CYAN background. Previously, they are not highlighted. 

Issue now fixed. 

• Case 48503 

When *INCLUDE_TRANSFORM is used to read a file and the label increment for sets IDSOFF 

is used, this can cause problems if the file contains *SET_xxx_COLLECT. This is because the 

rule in LS-DYNA is that IDSOFF is applied to all sets except _COLLECT ones. Therefore, you 

can end up with the situation: 

- Some card references set N, which gets incremented to a reference to set (N + IDSOFF). 

- However if set N is *SET_xxx_COLLECT its label is not incremented and the reference 

becomes unresolved. 

This problem showed up when reading a dummy include file in which the *DUMMY cards after 

*END made references to set N. Read in isolation, or as an include transform with IDSOFF 

unset, this worked fine. However, when read with IDSOFF set it broke the dummy definition in 

PRIMER. 

To get round this problem, a new ‘*SET_COLLECT in *INCLUDE_TRANSFORM’ switch has 

been added to the [Model] Read → Options panel. This has two settings: 

(1) Read like LS-DYNA, the default, which will exhibit the problem above 

(2) Map unresolved references to set 

Option (2) above will look for the combination *SET_xxx_COLLECT N and undefined 

*SET_xxx (N + IDSOFF). If it finds this then it presumes that the references to set (N + 

IDSOFF) should in fact be to set N and remaps them. This is not technically correct, but it may 

provide a means of reading a model with this problem and then fixing it. 

• Case 48464 

PRIMER was sometimes crashing when the ‘EDIT’ function was called for an entity in an 

encrypted dummy-tree include file. Fixed this. 

Edit 

• Case 53615 

Deleting entry row on the *DEFINE_TABLE edit panel caused error messages in dialogue box. 

Now fixed. 

• Case 53191 

Fixed a bug in PRIMER that gave out errors in MS DOS window when resizing the 

Create/Modify panels built by generic editor. 

• Case 51622 

The ‘Text Edit’ button was greyed out in the *INITIAL_VELOCITY_GENERATION edit 

panel. Now fixed so that text edit is available for *INITIAL_VELOCITY_GENERATION. 
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• Case 50762 

The open-ended second card of the *EM_POINT_SET keyword was previously not accessible 

through the create editor in PRIMER. This is now fixed. We can now add and remove instances 

of the second card. 

Elements 

• Case 51560 

The deletion hierarchy for *ELEMENT_BEAM and *ELEMENT_BEAM_PULLEY has been 

corrected. Deletion of BPULL will not delete elements BID1, BID2. Deletion of these beams 

will cause the BPULL to be offered for deletion. This change has corrected an erroneous beam 

deletion seen in the model from visible function when applied with non-visible BPULL. That 

function has further been improved so that visibility of BPULL is implied if the underlying 

beams are visible. 

• Case 48394 

Orient copy with elements in same part (no part copy) when applied to 

*ELEMENT_BEAM_THICKNESS with ELFORM = 6 did not copy the coordinate systems. 

The copy operation has been modified to recognize that PARM3 is CID in this case and new 

CIDs will be generated. Issue fixed. 

Encryption 

• Case 50410 

Previously, encrypting curves within define tables with full encryption caused errors because 

PRIMER does not associate the PGP blocks in the correct places. This only occurs if you tried to 

fully encrypt a curve within a table but did not encrypt the full table. Now, when you select a 

curve that is referenced by a table, a warning is thrown when using the encryption tool. The issue 

is now fixed. 

Favourites 

• Case 51683 

The Favourites menu for both Tools and Keywords would previously elide duplicate buttons 

specified using standard PRIMER terminology. However, text edited buttons still appeared 

multiple times previously. 

To fix this, the duplicate check has now been extended to cover both custom tools (scripts for 

examples) and buttons for which custom text has been defined. In case custom text is 

encountered, the duplicate check is carried out based on core functionality and not based on the 

button text. 

• Case 51440 

Some *DEFINE and *INTERFACE keywords that previously could not be edited in PRIMER 

were, nevertheless, available in the Favourites menu for keywords. This has been fixed and these 

keywords are no longer in the Favourites menu. 
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Frequency 

• Case 51163 

Two issues were identified and fixed: 

- For *DATABASE_FREQUENCY_BINARY, the frequency fields (e.g., FMIN, FMAX) 

did not have units associated. The issue is now fixed. 

*DATABASE_FREQUENCY_BINARY units now apply.  

 

- For *FREQUENCY_DOMAIN_SSD_SUBCASE, the subcase CASEID must contain a 

letter. PRIMER did not check for this previously. Issue fixed. There is now an error 

check to make sure there is a letter in CASEID for 

*FREQUENCY_DOMAIN_SSD_SUBCASE. 

Geometry 

• Case 52859 

Previously, PRIMER could not read in a STEP file that contained a DIRECTION() entity 

defined by only two components. This has now been fixed. 

Graphics 

• Case 53800 

When using FIND to identify items by sketching them and centring the crosshairs on them, the 

centre of rotation for dynamic viewing should update to be at the crosshair’s centre. This worked 

when the first item was ‘found’ but for second and subsequent items the crosshairs moved but 

the centre of rotation did not. 

 

This was due to an internal error. The issue is now fixed. The centre of rotation will now move to 

the crosshair’s location at the centre of each newly picked item. 

• Case 52874 

PRIMER would crash if display colour settings were reset for all models when the models with 

model number lesser than highest used model number was deleted. Fixed this. 

• Case 52230 

In some places in PRIMER, a repeated sketch operation could cause the wireframe sketched 

overlay to ‘thicken up’ in appearance, making the image look more congested. 

 

This was due to the way sketched graphics were drawn which has been revised to give a crisper 

appearance which does not ‘thicken’. Issue now fixed. 

• Case 51543 

Nodes and item labels can be set to be drawn as ‘Not bg’ in PRIMER to provide a contrast 

against the background. When this is done and the background colour is updated (Display → 

Colour), node and beam labels do not immediately get redrawn in a new colour. This issue has 

now been fixed. 
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• Case 47809 

Previously, when turning on labels or names in the entities panel for CONNECTION, TARGET, 

TARGET MARKER, or GEN_GRAPHICS, drawing of these entities was not also turned on 

(with ‘Automatically display labelled/named entity types’ turned on). This has now been fixed. 

Groups 

• Case 50092 

Previously, the labelling of the contents of a Group in the Group creation/modification panel was 

unclear as it only showed the contents of the Group in terms of the data entries (number of ‘All’, 

‘Range’, and ‘List’ for a given entity type). Issue fixed. Now, alongside this label, there is also a 

label listing the actual number of a given entity contained within a Group. 

 

Additionally, the Only/Blank/Unblank buttons only changed the visibility of the model based on 

the contents of the original definition of a Group previously. Therefore, the buttons seemed to be 

out of date when modifying a Group or were not even available when creating a new Group. 

This has now been corrected such that the buttons are available when creating a new Group, and 

they Only/Blank/Unblank the contents of the current modified definition of the Group. 

• Case 50091 

Previously, the Group panel did not automatically refresh after Import. Now fixed. 

IPP 

• Case 52626 

The final test on length of the rod in FMVSS201 mode should shift the base point in Y to align 

with target point before measuring to centre of the head. Previously, we used H-point which is 

correct for ECER21, but over estimate for FMVSS201. Issue now fixed. 

IGA 

• Case 53344 

In the *CONSTRAINED_NODAL_RIGID_NODY create/modify panel, the space between the 

last 2 rows was missing. Repositioned the IDTHRM row. Issue fixed. 

Include 

• Case 52122 

Include replace was failing to delete the old connections of the replaced include, instead these 

were left in a latent state. They are now deleted. Issue fixed. 

• Case 51790 

PRIMER would previously not read in additional files specified by *INCLUDE_COSIM cards. 

This has now been fixed. Additionally, these files can now also be imported into a model via the 

Include tree as can be done for regular structural includes. 

• Case 51656 

Fixed bug for renaming the file name during edit in *INCLUDE for _AUTO_OFFSET, 

_COSIM, _UNITCELL, _TRANSFORM and *DUALCESE cards. 
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JavaScript API 

• Case 53504 

There was an issue of memory leak, when performing repeated contact penetration checks with 

the default threaded contact assembly setting. An improvement has been made for PRIMER 

21.0, but the full fix for this issue is expected in future releases. 

• Case 53009 

Running a script with a GUI created from the GUI Builder would crash if the name of a Widget 

used the name of a Window property (‘top’, ‘bottom’, ‘keepOnTop’, etc.). 

 

The GUI Builder has been updated so it will no longer allow you to set the name of a Widget to 

the name of a Window property. Issue fixed. 

• Case 52576 

When a JavaScript in PRIMER, D3PLOT or T/HIS had got a Widget object with the onTimer 

property set to a callback function again mapping windows, the program crashed. This happened 

for example with Window.Message, Window.Warning or Window.Error in the callback 

function. This has now been fixed so that the window is mapped with the time delay specified in 

the timerDelay property. 

• Case 52567 

If a WidgetItem was used in a tree widget, updating the text property of the WidgetItem did not 

update the tree. Now fixed. 

• Case 52493 

Tree widgets could not be made with a vertical size greater than 149. Now fixed. 

• Case 52148 

In the JointStiffness (Jstf) class for PRIMER JavaScript, the property to add a title was missing. 

Added the missing property as ‘heading’. Issue fixed. 

• Case 51933 

When we do Part.GetFlagged for a group containing parts, an array containing the parts was not 

getting returned. This has been fixed now. 

• Case 51872 

Find attached run off JavaScript was significantly slower (10x) than interactive. This has been 

improved. By threading a core routine, it is now only 2x slower. Issue fixed. 

• Case 51844 

The solid constructor in the PRIMER JavaScript API used to take up to 27 nodes. It is out of date 

since solids can have up to 64 nodes. The old constructor has been deprecated and a new solid 

constructor that has only 2 arguments has been added. The second argument of the new 

constructor is an object that has a nodes array property. This array can have up to 64 node labels. 

Issue now fixed. 

• Case 51415 

A window could be left in a zombie state in an rare case of trying to minimise a window from 

JavaScript during a call to Sleep() before the window was hidden. Now fixed. 
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• Case 49938 

Previously, JavaScript error messages got clipped. Now fixed. Error messages in the 

INFORMATION window will now show properly and not get clipped. 

• Case 48395 

Previously, JavaScript Copy functions failed to copy the include property. Now fixed. 

Added a new property to the Options class (Options.copy_target_include) that controls the target 

Include of copied elements/keywords, this can be set once to control the behaviour for the whole 

script. You can select it to go into the current include (Include.COPY_INTO_CURRENT) which 

is the default option or to copy new elements into the Include of the original source element 

(Include.COPY_INTO_SOURCE). You can also specify a specific Include number in which the 

new elements should be put into. 

Keyword 

• Case 53486 

Fixed a *BOUNDARY_THERMAL_WELD_TRAJECTORY keyout bug which caused Card 3 

to output an extra field when the field IFORM was assigned a value of 5 (specific to R10 output). 

• Case 53146 

Macro tags pertaining to *INITIAL_VOLUME_FRACTION_GEOMETRY and 

*INITIAL_PWP_NODAL were previously set up incorrectly. Macros pertaining to object menu 

selection for those keywords would record and play back correctly but would look odd. This 

issue has now been fixed. Old macros will need updating. 

• Case 52980 

Previously, PRIMER incorrectly complained about missing lines when reading in *MAT_068 

without optional cards. This issue is now fixed.  

Additionally, optional cards on *MAT_NONLINEAR_PLASTIC_DISCRETE_BEAM 

(*MAT_068) are no longer written out if they do not contain data. If *MAT_068 needs to be 

read into a previous version of PRIMER, please set the preference ‘mat_68_write_all_cards’. 

• Case 52902 

The following bugs are fixed in *FREQUENCY_DOMAIN_RANDOM_VIBRATION keyword: 

- Incorrect values were read-in/copied during the key in of fields LDSPSD2 and LCTYP2. 

This is corrected now. 

 

- The field NCPSD on card 3 and it is corresponding card 6 were valid for only 

_FATIGUE option. Now they are made generic. 

• Case 52459 

*BOUNDARY_PRESCRIBED_ORIENTATION_RIGID_ANGLES_ID needs a header for 

every card. However, PRIMER did not write out the header for every instance of the keyword 

previously. This bug is now fixed. PRIMER will now write out the header for every 

*BOUNDARY_PRESCRIBED_ORIENTATION_RIGID_XXXX keyword. 

• Case 51241 

There were issues reading in *DUALCESE_CONTROL_SOLVER and *DUALCESE_D3PLOT 

previously. This is now fixed. 
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• Case 51215 

We have changed the logic for handling duplicate damping definitions for 

*DAMPING_PART_MASS and *DAMPING_PART_STIFFNESS. Previously, creating a 

duplicate damping definition for an existing PID or PSID would overwrite the old definition 

without any warning. Additionally, if a *DAMPING_PART_MASS or 

*DAMPING_PART_STIFFNESS card is created for a part referenced by a set in an existing 

*DAMPING_PART_MASS_SET or *DAMPING_PART_STIFFNESS_SET the part was 

removed from the set referenced in the _SET card. 

 

Given that DYNA accepts duplicate damping definitions, and to avoid any issues with automatic 

deletions, a warning check was added for duplicate damping definitions and the logic for 

deleting existing cards or parts from sets was removed. Issue resolved. 

• Case 51054 

In the *DATABASE_HISTORY_NODE editor, there was a crash when unselecting all suffixes 

in filter options. Issue fixed. PRIMER will no longer crash. 

• Case 50296 

Reorganised and fixed the creation and keyword panels for 

*BOUNDARY_RADIATION_SEGMENT and *BOUNDARY_RADIATION_SET, including 

ensuring correct keyout with full backwards compatibility. 

• Case 49905 

In *EM_CIRCUIT keyword, the _SOURCE suffix option was available in the keyword editor 

panel but it was missing in the create panel. Issue now fixed. The _SOURCE suffix option is 

now made available in the create panel as well. 

• Case 49203 

Previous versions of PRIMER could process the keywords *DUALCESE_MODEL and 

*DUALCESE_INCLUDE_MODEL but would not read in the files specified by these cards. This 

has now been fixed and the additional files can now be read in by PRIMER. 

An error check has also been added to flag the presence of non-DUALCESE cards in these files. 

These new files are now available on the Include tree. Additionally, these two keywords are now 

editable by right-clicking on the relevant nodes in the include trees. 

Keyword Editor 

• Case 52595 

It is possible to select a subset of materials using Quick Pick for display in a keyword editor. 

This worked correctly, showing only that subset of materials, but the header rows at the top of 

the table made it appear that all possible types of material were being shown rather than just the 

subset represented by the selected materials. Now fixed. The header rows in this case will only 

show the types of the materials in the list below. 

Labels 

• Case 52121 

When capturing images in 2 times or 4 times the resolution, some labels would not be written out 

properly. This has been fixed now. 
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Loading 

• Case 51791 

When all parts in the set of a *LOAD_BODY_PARTS keyword are deleted, subsequent cleanup 

operations will remove the *LOAD_BODY_PARTS. If other *LOAD_BODY instances are 

present, these will then apply to the whole model. It is preferable to delete all *LOAD_BODY, 

so cleanup has been modified to do this. Issue resolved. 

Manual 

• Case 52648 

Previously, some tutorials were missing from the list of Help → Tutorial. Issue now fixed. All 

available tutorials are now displayed in the application. This change lets you access the entire 

range of tutorials without restrictions. 

Mass 

• Case 53753 

Some materials (*MAT_084_REINF, *MAT_148, *MAT_215) do not have density defined in 

the 2nd field. PRIMER cannot calculate mass for these parts. Previously, PRIMER might report 

an incorrect mass. Now, PRIMER 21.0 returns zero mass. Issue fixed. 

Materials 

• Case 52601 

Previously, PRIMER did not support negative LCREGD for *MAT_ADD_EROSION. Issue 

now fixed. LCREGD on *MAT_ADD_EROSION can now sport negative values which would 

translate to a table input. An error check has been added to ensure that negative values refer to 

tables and not loadcurves. An additional keyword check has been added to ensure that negative 

values only apply to LS-DYNA R9.0 and above. 

• Case 49980 

There were some issues in the material selector panel. Now fixed. Material Name and Material 

Model fields in the material selector panel now have hover texts. This panel can be launched by 

clicking on the import button in *MAT panel in PRIMER. Additionally, the material names are 

no longer capitalized automatically, which means that material names in the oa_index file are 

now case sensitive. 

Mechanism 

• Case 48568 

Previously, the way positive and negative sliding limits on sliding joints are defined in 

mechanisms was not quite right. Issue is now fixed. In PRIMER 21.0, we added an option to 

change how mechanism sliding limits work. The new relative limit type treats the limits as 

signed numbers allowing the sliding limits to work the same way as the rot’n limits. The 

behaviour of the sliding limits can be selected using a dropdown in the move Connection list 

panel and the selected type is saved to the *CONNECTION_LINE keyword. The old limit 

behaviour remains as the default behaviour. 
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Menus 

• Case 53725 

The Quick Pick ‘Label’ submenu disappears when a selection was made within it. This is now 

fixed, and the submenu stays until we close that panel or clicked outside. 

Also fixed a problem where the popup menu does not move along with its parent menu (in the 

Workflows panel). 

• Case 51203 

Previously, fields which do not require input were not greyed out for *CONTROL_ACOUSTIC 

and *CONTROL_ACOUSTIC_COUPLING in the *CONTROL editor. This issue has been 

fixed. Now, we have greyed out buttons in *CONTROL_ACOUSTIC and 

*CONTROL_ACOUSTIC_COUPLING for the empty fields at end of each card. 

Merge 

• Case 52574 

Model merge requires a reasonable tolerance. Previously, applying the default of 0.1 to a model 

in metres caused the process to hang. Issue resolved. Now, if the model is detected to be in 

metres the tolerance of 0.1 will now be changed to 1e-4. 

Mesh 

• Case 53746 

Fixed a bug that occurred when a group of shells that contains more than two shells sharing the 

same edge is selected during Remesh area in PRIMER. 

• Case 53163 

Previously, PRIMER would crash intermittently when generating a surface from mesh via the 

‘Mesh->surf’ tool. This has now been fixed. 

• Case 52907 

Some inputs to second feature line angle under mesh improvement options were leading to a 

crash. This is fixed now. 

• Case 51430 

Previously, an error would occur when trying to create swages mesh on shell entities with 

connections. Fixed this. 

• Case 50565 

A crash when using the ‘Add nodes around spotweld’ option while making connections on a flat 

plate with no feature lines has been fixed. 

• Case 46326 

In Mesh → Extrude, after Apply, selections used to get cleared. This is now fixed. Now, you 

continue extruding after Apply. You should change the direction after each Apply or it will keep 

extruding the same nodes in same direction. 
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Morphing 

• Case 53581 

Previously, a morphing operation could potentially not be added to the list of operations that 

could be undone by the Undo button in the morphing panel if that morphing operation was 

interrupted by dynamic viewing. Further to this, if some morphing was applied to a morph box 

and the morph box was deleted, it was possible to trigger a crash if the Shift/Ctrl button was 

released before the mouse button while doing some dynamic viewing with the morph panel open. 

These issues have now been fixed. 

• Case 52257 

Previously, it could be difficult to tell which morph points were selected when using the 

morphing tool. This has now been improved. 

Nastran 

• Case 51083 

PRIMER was not translating *CONSTRAINED_INTERPOLATION correctly to RBE3 when 

the independent nodes are input as a node set. This is now corrected by spooling over the node 

set and adding the nodes present inside to RBE3. 

• Case 48447 

Previously, RBE2 were not getting written out in wide format. Issue fixed. PRIMER can now 

write and read RBE2s in wide format. 

• Case 37058 

Previously, there was a problem writing Nastran files with label clashes. Now fixed. Label de-

clash is now performed automatically before Nastran write. If the model has already been de-

clashed there will be no change. 

Node 

• Case 52348 

Previously, *PART_MOVE with *CONSTRAINED_EXTRA_NODE behaved differently in 

PRIMER and LS-DYNA. Now fixed by changing PRIMER to be consistent with LS-DYNA. 

*PART_MOVE when applied to a rigid part that uses *CONSTRAINED_EXTRA_NODE will 

now move those nodes too. 

Output 

• Case 50246 

Previously, when writing out a model after setting up a Frequency Domain FRF analysis in the 

Implicit Setup tool, the Model → Write filepath could be prepopulated with a filename in the 

temporary files area. This has now been fixed. 
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Parameter 

• Case 53613 

The ‘local’ property on the JavaScript API Parameter class could sometimes have the value true 

even for parameters which had not actually got the _LOCAL suffix defined. This happened with 

duplicate parameter names in the model when there was either no 

*PARAMETER_DUPLICATION or a *PARAMETER_DUPLICATION setting of 1, 3 or 5. 

Issue fixed. Now, it is true if and only if the _LOCAL suffix is defined regardless of duplicate 

names and duplication settings. 

• Case 52550 

When a _LOCAL parameter was defined inside an *INCLUDE_TRANSFORM file, it could get 

confused if a reference to the parameter was made in an earlier include, generating errors on 

input and creating an extra spurious parameter. 

It was wrongly using the include file of the earlier reference to the parameter as its ‘include file 

of residence’ and since it was _LOCAL this meant that its scope was being applied wrongly. 

Issue fixed. The parameter will now be resident in the correct include file. 

• Case 52518 

Include find modified was not working after parameter modify. Processing of parameters (and 

some *ALE cards) uses an internal keyout which was incorrectly overwriting the internal name 

of the file hence model modified was unable to find it. Issue now fixed. 

• Case 49102 

The UNDO option was not working properly for renumbering in models which had parameters. 

The panel which comes up to show the list of parameters that would get changed when 

renumbering happens comes up again when the undo button is pressed after renumbering. This 

has been fixed by applying CHANGE_ALL option automatically when UNDO is pressed. 

A new option has also been added under UNDO category in program options which controls the 

above process. If un-ticked it brings up the panel of differences during the UNDO process. 

Additionally, a new preference has been added for the new option in program options. 

• Case 46842 

Resolved some parameter related inconsistencies: 

1) Parameter creation (Keyword → PARAM → Create): 

o Changed initialisation from type I value 1 to type I value 0 

 

2) Latent parameter modification (Keyword → PARAM → Modify) 

o Changed display from type ? value ? to type ? value 0 

Part Table 

• Case 53514 

Previously, the Part Table did not display Part Contact data for IGA Parts. Now fixed. The Part 

Table has been corrected to allow setting Part Contact on IGA parts. 
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Pedestrian 

• Case 53294 

Previously in the pedestrian markup tool, clicking Apply in a part/surface selection window 

without selecting any parts/surfaces would not update the status of the markup apply button. If 

the markup apply button was then pressed, the tool could throw some exceptions. This has now 

been fixed by ensuring that the markup apply button is greyed out when required data is missing. 

• Case 50533 

Previously, when using the Pedestrian Markup tool, if the WAD 1000 line was in front of the 

BLE while running a GTR/UN R127 based protocol, it was possible for some incorrect 

additional child head impact points to be generated. This has now been fixed. 

Program Crash 

• Case 53536 

Keyword Edit of *LOAD_SEGMENT with large number of entries (~50000) took several 

minutes to complete update and may on some platforms incur a crash. The logic has been 

modified to avoid excessive resorting of the label list to fix the problem. 

Program Hanging 

• Case 52338 

When we turned the 3D graticule ON and rotated any model like a flat plate, if the model 

becomes parallel to any of the X-Y,Y-Z or X-Z planes, PRIMER got stuck. This was because 

when the model became parallel to any of the planes, the difference between xmax/xmin or 

ymax/ymin or zmax/zmin of the model almost became zero. We have added a sanity check to fix 

this issue. Instead of having a flat plate when the model becomes parallel to any of the planes, 

we now get a box. 

Python API 

• Case 53150 

When we changed the port number to a different number than the default value then started and 

stopped the connection, the value in the text value reverted back to the default value. This has 

been fixed now. 

Read 

• Case 53864 

When reading LS-DYNA input files using the default threaded method, a crash could occur if 

the child thread was stalled for more than 10 seconds due to a network problem. The problem 

can be worked around by turning off threaded input in [Model] Read, options. This crash was 

caused by improper handling of this ‘stalled read’ situation and has now been fixed. 

• Case 53045 

The following sequence in the input deck caused PRIMER to reject the deck stating that the 

input was garbled: 
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*MAT_ADD_EROSION 

card data 

PGP encrypted data block 

This was because of internal errors in the way *MAT_ADD_EROSION was considering PGP 

encrypted data to form a partially encrypted keyword. 

This issue is now fixed, and potential similar errors in other *MAT and *MAT_ADD keywords 

are also fixed. 

• Case 52612 

Previously, PRIMER did not flag *INCLUDE_PATH that used relative path as an error during 

model read. Issue fixed. PRIMER will now report a keyin error if *INCLUDE_PATH using 

relative path is read. 

• Case 51638 

Previously, PRIMER did not allow duplicate *DEFINE_FRICTION cards. Issue fixed. PRIMER 

now merges multiple *DEFINE_FRICTION definitions with same label while reading the key 

file. Card 1 (row containing label) of the duplicated definitions is ignored while reading in the 

model. 

• Case 51540 

PRIMER was previously failing to read a *DEFINE_FUNCTION card that contained one or 

more commas in the title field. This issue has now been fixed. 

Renumber 

• Case 53743 

Previously in the Model → Renumber → Visualise panel, the initial ‘Move to’ value is ‘1’ and 

you could renumber blocks accidentally. Issue now fixed. The initial ‘Move to’ value has been 

changed from ‘1’ to ‘0’ to prevent accidental renumbering of blocks. 

Rigidify 

• Case 52533 

When simplify rigidify delete is applied to a lead part in a merge which is itself chained to 

another, the part should not be deleted. In some cases, depending on order of merges it was 

incorrectly deleted. This has been fixed. 

Scripting 

• Case 53818 

Inputting a file path with spaces into the load curve textbox was not functioning correctly. This 

issue has been fixed now. 

• Case 53742 

During include transform, the define curve functions were getting renumbered twice which has 

been fixed now. 

• Case 53353 

The HIC tool was unable to open T/HIS or open D3PLOT on Linux. This has now been fixed. 



Oasys Ltd LS-DYNA Environment Software Release Notes 

Version 21.0 
 

Ove Arup and Partners Limited | Final | May 2024  

 

Page 25 
 

• Case 52513 

Previously, the FMH markup tool considered markup points that were incorrect. This has been 

fixed. Additional checks have been added to the FMH markup tool (FMVSS201U) to prevent 

consideration of incorrect markup points. This should improve the calculation of the AP1 point 

in particular. 

• Case 50635 

Previously on the SPH MESH GENERATION panel (SPH-MESH JavaScript), the part selected 

for PID got deselected after pressing cancel. Issue resolved. Clicking ‘Cancel’ now retains the 

already selected part/parts. 

• Case 43150 

For ICFD Setup tool: 

- Some textboxes were not wide enough for large values, which has been fixed now. 

- The scrollbar was not updating with changes to number of boundaries, which has been 

fixed now. 

Sensor 

• Case 48822 

Previously, PRIMER issued an error message when we try to create a *SENSOR_SWITCH with 

SWITID changed to the label of a latent *SENSOR_SWITCH. Issue fixed so that relabelling 

*SENSOR_SWITCH no longer issues an error message in the command window. 

Additionally, the radio buttons for subtype were not mapped on the create/modify 

*SENSOR_SWITCH panel. This has also been fixed. 

Sets 

• Case 52618 

Previously, the object menu for sets in ADD mode only listed items that were not in the set. This 

has been corrected. The object menu for sets in ADD mode will now list all items. This allows 

you to make a selection that includes both new items and those already in the set, which is 

deemed to be less confusing. 

Sketch 

• Case 51691 

PRIMER draws some annotation information for joints when sketching said joints. Text colour 

was not being set correctly for said annotation with the result that they could appear in an 

unexpected colour or, in rare cases, even appear to shift colours. This issue has now been fixed 

and joint annotations are also depicted in the user-specified sketch colour. 

• Case 48304 

Previously for IGA type part, no arrow was drawn when sketching 

*INITIAL_VELOCITY_GENERATION. Issue fixed. PRIMER now draws an arrow on the 

centroid of the IGA type part for *INITIAL_VELOCITY_GENERATION. 
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Transform 

• Case 52945 

LS-DYNA permits duplicate node label definitions so long as the coordinates of the duplicates 

are coincident. One way of modelling this is to have nodes in the model at coordinate A, and the 

same nodes in an include file at some position B which *INCLUDE_TRANSFORM moves to 

coincident position A. In this situation, PRIMER creates a single unique definition for each node 

and makes the copies in the include file ‘clones’ of the this. 

An error in PRIMER 20.0 meant that, depending on the order of the include files, such a model 

might not transform the nodes correctly resulting in a refusal to read the model because the 

duplicate nodes were (wrongly) not coincident. 

Earlier versions of PRIMER would read this model correctly. However, those earlier versions 

would write out the nodes in the include transform file in their as-transformed position, 

coordinate A in the example above, rather than their original untransformed position, coordinate 

B. 

 

Both problems have been fixed in PRIMER 21.0. 

User Interface 

• Case 53343 

Previously, the directory button in the Pedestrian Markup tool, upper leg impact points section, 

did not appear to be a button. This has now been fixed. 

• Case 53292 

Previously, some keyword editor row on/off buttons were not big enough, resulting in truncated 

row number. Fixed this. Made the row on/off button in the keyword editor big enough to hold the 

row numbers according to the number of digits the row number has. 

 

Also fixed the column sort function where the alpha entries were not sorted properly. 

• Case 52296 

Previously, the Apply button on the ‘Database for CREATE MODEL’ (Model → Build → 

‘Select existing xml database’ → Apply) panel was incorrectly written in all-caps. Corrected this 

Apply button. 

• Case 51481 

The rows of the object menu in Safety → Dummies → Position → Move parts → Save/Retrieve 

→ Delete were not getting highlighted when selecting them. Now fixed. 

• Case 50632 

Dealt with issues related to Model → Build → ‘Select existing xml database’: 

1) The ‘Keyword file:’ and ‘Thumbnail:’ textboxes on the ‘Add entry to database’ panel 

(accessed via ‘INCLUDE FILE FOR MODEL BUILD’ tree → ‘Add new child’ → 

‘Type:’ → ‘LS-DYNA keyword (.key)’) were right aligned and looked weird. This is 

now fixed. 

 

2) On the same panel as (1), fixed text ‘select version:’ with all lower case by updating to 

‘Select version:’. Additionally, tick boxes on the ‘COMPONENT VERSION 
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CONTROL’ panel (accessed by clicking on ‘List’) previously looked wrong (not 

consistent with other tick boxes in PRIMER). Now fixed. 

 

3) On the same panel as (1), in the extra data section (activated by clicking ‘Add extra data 

.key file’), fixed buttons with all lower case text ‘usage’ by updating to ‘Usage’. In the 

same extra data section, the file textboxes were right aligned and looked weird. This is 

now fixed. 

 

4) Fixed labels and popup buttons with all lower case text on the ‘EXISTING ORIENT 

POINT(S)’ panel (accessed via ‘INCLUDE FILE FOR MODEL BUILD’ tree → ‘Edit’ 

→ ‘Create orient’  → ‘Add tracked orient point to database component’) by capitalising 

the first letter. 

 

5) On the ‘TEMPLATE CONTROL PANEL’, all buttons on the top looked the same. Issue 

fixed by making the ‘Reread all’ &’Quit’ buttons look different and more obvious. 

Additionally, many texts and buttons (especially for popups) are all in lower case. Fixed 

by capitalising first letter. On the same panel, there is a redundant ‘Help’ button (same as 

the [?] button). Button removed; issue fixed. 

 

6) The template name textbox on the ‘TEMPLATE CONTROL PANEL’ (accessed by right 

clicking on a template) is not clear. This is issue is fixed by making the textbox more 

obvious. 

 

7) ‘^’ and ‘v’ were used for the up and down buttons on the ‘MODEL BUILD PANEL’ 

(accessed by clicking on ‘Build Models’ on ‘TEMPLATE CONTROL PANEL’). This 

has been fixed by using icons instead. 

 

8) Additionally, on the ‘MODEL BUILD PANEL’, the tick boxes seem to resize vertically 

when hovering over them. They are now fixed. 

Occurrences of ‘LS-Dyna’ were replaced with LS-DYNA’ in PRIMER 21.0 to improve 

consistency within the program. 

• Case 49461 

Previously, out of date master/slave terminology was used in PRIMER. Issue fixed. Replaced the 

terms ‘slave’ and ‘master’ that appear on the PRIMER interface (e.g., buttons, print messages, 

help messages). Terms were updated based on category. 

Volume III 

• Case 51166 

Fixed a bug in the reading of *EM_RANDLES_SOLID, *EM_RANDLES_TSHELL, 

*EM_RANDLES_MESHLESS and *EM_RANDLES_BATMAC that was causing data from 

card 3.a to be incorrectly copied to card 4 when RDLTYPE<2. 
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Workflows 

• Case 52350 

Previously, there was an issue with the support of PDB WSID 50M in PRIMER. Now fixed. We 

now support both left-hand side and right-hand side PDB WSID 50M dummies of versions 4.0 

and 7.6. 

Write 

• Case 52290 

Previously, the Analysis Tracking Tool was not working because keyout was not interrupted by 

the Analysis Tracking Tool. Fixed this. 

Xref 

• Case 47768 

*DEFINE_CURVE_FUNCTION can refer to load-curves, nodes, parts, etc. Previously, they 

were not all supported with cross-references in PRIMER, and could lead to broken models. Now, 

they are all supported with cross-references. This will prevent accidental deletion of the item on 

cleanup (or otherwise). External label change will now update the contents of the function string. 

ZTF 

• Case 51985 

Writing a ZTF file for a model containing discrete beams with _OFFSET could cause a crash. 

 

In fact, the combination of discrete beams (ELFORM = 6) and the _OFFSET suffix is invalid in 

LS-DYNA. For this reason, some operations to configure the _OFFSET values were not 

performed prior to the ZTF file being written, and this caused the crash. 

 

The crash has been fixed by pre-configuring _OFFSET in this context regardless of beam 

element formulation. A check for the usage of _OFFSET with invalid ELFORM values has also 

been added. 
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2.2 D3PLOT 

3d 

• Case 51879 

Annotation marker positions were exported only for the annotation they corresponded to, so, for 

example, a marker on a static frame would be exported with only a single position. In the Viewer 

this meant markers would not necessarily animate correctly. Now the positions for all visible 

markers are exported for every annotation, so now in the Viewer they will animate correctly. 

• Case 50131 

When reloading a REPORTER item or an annotation D3PLOT could load a different state to that 

which was captured. This could happen if there were multiple models in a window with different 

numbers of states. This has been fixed. 

Animation 

• Case 53483 

In a D3PLOT session containing multiple models in multiple windows the State 

Slider/Animation Menu didn't always update correctly when windows were turned on and off. 

 

If all Windows were turned off and then one or more were turned on again the state slider would 

display state 0 even though the Windows were displaying a different state. 

Annotation 

• Case 53735 

When reloading annotations that included graphs, curves could be added to other graphs in the 

session, the graphs on the annotation page may not have updated correctly and sometimes graphs 

could be missing from the reloaded page. These issues have been fixed. 

• Case 53386 

Marker symbol sizes varied with display resolution and window layouts. This has been fixed. 

Also, marker text size now set by label text size in Display Options >> Fonts. 

Annotations with a window containing 3 or more models could be reloaded with the models 

appearing in the model list in a different order to when the annotation was captured. This has 

been fixed. 

Blanking 

• Case 50165 

Fixed an issue where the blank lock status was being reset to false when a new model was read 

in. 
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Capture 

• Case 51958 

Following a settings and properties file read, parts could blank and unblank in the graphics 

window when rotating the model. This has been fixed. 

• Case 51956 

When reloading a capture with a command file from REPORTER, D3PLOT now makes sure to 

update the graphics when the command file is done executing. 

Component 

• Case 52411 

D3PLOT could crash if you created a user defined data component that used another user 

defined data component as one of the inputs. 

Contour 

• Case 52134 

Contours were not recalculated correctly when during an animation multiple cut sections were 

changed. This happened for custom spacing in one direction, when positions were added, deleted 

or modified. Also, with multiple directions any changes to the second or third direction did not 

trigger recalculation of contour bounds. Now the contour bounds update as expected in these 

cases. 

• Case 52099 

In D3PLOT, contour plots displayed wrong maximum and minimum labels at the top left corner, 

when users first displayed state 0 and then the last state from the result file. This is now fixed. 

• Case 51942 

With multiple models in one window and the default 'Auto all frames', contour bounds were 

correctly calculated across all frames in the animation, but with the Pause button in the 

animation they went back to those for the current frame. With a single model it is only the state 

slider changing back the bounds to the current state, but Pause in the animation keeps the bounds 

across all frames. Now multiple models in the same window behave in the same way as a single 

model. 

• Case 51719 

Added a contour range label in D3PLOT. This label provides context to the contour data on a 

contour plot. The label describes the extremal values. This will allow images captured from 

D3PLOT to retain the contour mode information. Range label is 'Range: all frames', 'Range: 

current frame', 'Range: all windows' for auto all frames, auto each frame, auto all windows 

modes respectively. Range label is 'Range: current state' when the contour plot displays state 

data. And the Range label is 'Range: automatic' for envelope plots in automatic contour modes 

and 'Range: user defined' for envelope plots in user defined contour modes. 

• Case 49178 

Until now D3PLOT could not determine whether a beam element was integrated or resultant. 

Consequently, integrated and resultant beam components were plotted on all beam elements. In a 

model with both types this would lead to inapplicable results, for example a plot of XX axial 
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stress, an integrated component, would show total axial strain on resultant elements. 

 

Now, if a ZTF file is available, D3PLOT uses the section information to identify which type 

beam elements are and only plots applicable components on them. There is a switch in Display 

Options >> Beam Symbols >> Ignore Beam Type that can be set to on to override this and plot 

integrated and resultant beam components on all beam elements. This switch can be set with 

preference d3plot*ignore_beam_type ON/OFF. 

Cut section 

• Case 52929 

When on the cut section panel with the LS-DYNA definition method a 

*DATABASE_CROSS_SECTION is imported, the same normal tail, normal head and edge 

head come across only for the _PLANE suffix. With the _SET suffix 

*DATABASE_CROSS_SECTION has not got these coordinates defined, so importing does not 

make sense. Previously D3PLOT had got corrupted coordinates in the cut section definition in 

such an import and sometimes crashed. Now there is an error message, and the previous cut 

section definition is retained. 

• Case 52488 

In version 20 onwards of D3PLOT some threaded (parallel) code was added to speed up cut 

section calculations and display. 

 

In version 21 a new option has been added into the 'Tune->Threading' menu that can be used to 

turn off the cut-section threading logic if required. 

 

A new preference has also been added 

 

d3plot*thread_cut_section 

 

that can be set to TRUE or FALSE to turn ON/OFF the threaded logic. 

 

By default the logic is ON. 

• Case 52484 

When a model was open in D3PLOT with cut section custom spacing and the model was closed 

while the cut sections were still active, then D3PLOT could crash after opening another model. 

This has now been fixed. 

• Case 52456 

When a cut section defined by the LS-DYNA method was dragged with the middle or right 

mouse button for rotation, the coordinates on the panel did not update correctly. 

 

Also, when another definition method is switched to the LS-DYNA method on the panel, the 

normal head and edge head appeared as 0.0 0.0 0.0 on the panel, whereas now they are 

calculated automatically so that the plane defined by the LS-DYNA method appears in the same 

location as the plane defined by the previous method. 

 

Typing in an origin coordinate in the text box did not update the drawing of the plane as 

expected. Now it retains the normal and edge heads and updates the plane position as expected. 
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When there was a linked PRIMER session, any cut plane defined in D3PLOT by the LS-DYNA 

method came across to PRIMER in the correct location, but with the normal and edge vectors 

scaled to unit length and made orthogonal. Although this defined the correct plane location, it 

was less obvious from the numbers on the panel that the planes were actually the same. Now the 

normal head and edge head coordinates are sent across without changing any vector lengths so 

that the numbers are the same in both linked programs. 

• Case 52433 

When the cut section panel was open in PRIMER and D3PLOT at the same time while they were 

linked in the integration and the definition type was changed in PRIMER, sometimes D3PLOT 

still showed the wrong buttons. For example, if in PRIMER the type was changed from 'Constant 

X' to 'Origin and vectors', then the button in D3PLOT would show 'Origin and vectors' as well, 

but D3PLOT would still have shown the text box for the constant X coordinate rather than the 

origin and vectors. Now the text boxes are shown for the new definition type in both programs as 

expected. 

• Case 52331 

For *PART_CONTACT the thickness OPTT and the scale factor SFT were picked up in 

D3PLOT from ZTF files. This becomes visible for example in cut sections when in the element 

capping the PART_CONTACT thickness is selected. When this option was used in composites 

with *PART_COMPOSITE_CONTACT, then the thickness and scale factor did not appear in 

D3PLOT. This has now been fixed so that they appear in the same way as without 

_COMPOSITE. 

• Case 48663 

The default spacing for parallel cut sections was based on the model dimensions the first time in 

a D3PLOT session. If then all models were closed and a new model was reopened, the same 

spacing was used again even when the new model had got very different dimensions. Sometimes 

the planes in the new model were slow to draw because there were too many of them with a too 

small spacing. Sometimes the planes may not become visible at all when the spacing is greater 

than the model dimensions. Now D3PLOT recalculates a default spacing for the new model in 

these cases. 

 

Also the thickness for thick cuts, custom spacing as well as the cut origin location are now reset 

similarly. 

Deform 

• Case 53817 

When using Fix Node, behaviour was inconsistent between screen picking a node versus keying 

a node ID into the text box. In the first case, the Fix Node switch would automatically toggle on 

when a valid node was selected, but not in the second case. This has now been made consistent 

so that the switch is always toggled on for a valid node. 

 

Additionally, it was sometimes possible to cancel the picking action before selecting a node, at 

which point it was not possible to restart it. This has now been fixed. 

 

Finally, in some cases of selecting a fixed node with multiple models active, a superfluous error 

message stating 'See warnings!' could be printed to the dialogue window, followed immediately 
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by a warning with the actual information required. In this case, this error is now suppressed from 

the dialogue window. 

• Case 51685 

Magnifications are now applied to modal analysis (e.g. d3eigv, d3ssd, etc) plots in d3plot to 

make it consistent with how it is done for Nastran frequency response functions. 

Dialogue command 

• Case 52355 

Fixed a bug regarding the JS function DialogueInput() for D3PLOT where the range of part IDs 

requested would infinitely loop if the part IDs requested were not present in the model. It will 

now not lock the program however it's recommended to check that the part IDs are valid before 

issuing any commands in this way to D3PLOT in order to ensure correct behaviour. 

Elements 

• Case 50568 

In D3PLOT 21 the PTF Compress Utility has been updated so that it now supports DES 

elements. 

Envelope 

• Case 53666 

Enveloped contour plots could get 'stuck' on models after enveloping was switched off due to 

contour resolution being changed on an envelope plot. The buttons for changing contour 

resolution are now greyed out if an enveloped window is the only / first selected window and if 

an enveloped window is selected but not as the first selected window the contour resolution for 

enveloped windows is not updated and will remain unaveraged until enveloping is switched off. 

• Case 52878 

If an envelope plot of a nodal data component (displacements, velocities, accelerations) was 

generated for a model that contained element deletion then the min/max values could include 

values from nodes which no-longer had any elements attached to them. 

Femzip 

• Case 52961 

Femzip reading from file paths greater than 256 characters were not allowed to be read into 

D3PLOT. This has now been fixed such that the upper limit is 512 characters. 

General 

• Case 49219 

The option to display Minimum and Maximum data values on top of a non-data plot (HI, LI, SH) 

didn't display any values. This has been corrected. 
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Geometry 

• Case 53985 

If data was plotted on a contact surface and the model also contained Airbag Particles then the 

lighting in SI plots was missing from the contact segments if the Airbag particles were being 

rendered using the default 'Fast Sphere' method. This has been corrected. 

Graphics 

• Case 52995 

When capturing images in 2 times or 4 times the resolution, some labels would not be written out 

properly. This has been fixed now. 

• Case 52873 

If some of the elements in a DES part were blanked and then the image was rotated so that the 

part moved off of the screen and back on again the when the part moved back onto the screen all 

the elements in the part would be displayed again. This has been corrected. 

• Case 44443 

If the Material Attributes menu or the Lighting menu was used to reposition the default light 

positions, then the vector position displayed in the menu was sometimes inaccurate due to 

rounding errors in the positioning calculation. 

 

There were also some menu issues that caused flickering and performance issues if you tried to 

edit the positions of lights when both menus were being displayed. 

Groups 

• Case 52549 

Blanking, and more probably unblanking, by group could sometimes leave things visible on the 

screen which should in fact have been blanked. This would not be very repeatable since it would 

depend upon what had happened previously, and in most cases you would never see this 

behaviour. 

 

This was due to an internal error in the way blanking was applied in some circumstances which 

has now been fixed. 

Integration 

• Case 53087 

The behaviour of cut section dragging when PRIMER and D3PLOT are linked together has been 

improved: 

 

- Initiating dragging in one code will also activate it in the other. 

 

- Some problems with cursor symbols failing to change correctly to show the current dragging 

state have been fixed. 
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• Case 49916 

Suppose that more than one model is open in D3PLOT, each in a separate window. If a PRIMER 

session was linked to the second model but not the first, then cut section locations were 

synchronised only if the first model/window was toggled off at the top of the cut section panel in 

D3PLOT. Now D3PLOT sends the cut section data from the first window containing a model 

also open in PRIMER. 

Javascript api 

• Case 53842 

Extracting von Mises, max principal or min principal stress from a shell element for a single on-

plan integration point at the middle surface could cause a crash. This has been fixed. 

• Case 53697 

Fixed a bug due to which the Item() function of SetNode class in Javascript always returned the 

node object of the first node from the node set, irrespective of the 'index' value that is passed as 

an argument to the function. 

• Case 53673 

Fixed GetData with components UNOV, USST and UBMV giving arrays full of uninitialised 

values. 

• Case 53609 

Fixed an issue where ALE Components ADOMF, AMMG and AMMS were not giving the 

expected results in the JavaScript API. There was a typo in the manuals were ADMOF was spelt 

as ADOMF so that was fixed too. 

• Case 53240 

Fixed a crash when using JS API function GetData with the ADENS component. Also fixed 

using GetData with ALE components ADOMF, AMMG and AMMS giving the incorrect values. 

• Case 53125 

In previous versions of D3PLOT, clicking the 'Debug' button twice in the JavaScript menu could 

make the JavaScript debugger inoperable. This issue has now been fixed. 

• Case 42163 

A bug where the JavaScript API function SetCurrentState() could not be set to 0 was fixed. 

• Case 38162 

Fixed a crash in the D3PLOT JS debugger when something was not being garbage collected. 

Labels 

• Case 53776 

If the option in the Entity to display the labels of Volume 3 Parts was turned on, then the labels 

were still not displayed correctly on plot. 

• Case 52906 

The use of wildcards such as '*' was working correctly from the various Tools menus but not 

from the quick pick box. Specifically, the following were not working correctly: 
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- '3* 4' would work correctly, but '3*' would not. 

- Specifying '3*', then 'Undo', then '*' would make D3PLOT execute a quick pick on the original 

pattern of '3*' rather than '*' (all) 

 

These issues have now been fixed. 

Materials 

• Case 50895 

In the material attributes panel if a vector was used to define the position of a light the vector 

displayed in the box after it had been normalised showed some rounding errors. 

Measure 

• Case 49108 

Part-Part measures were drawn at the wrong place when they were between two different models 

in the same window and one of these models had a model space offset. The measurement values 

were correct, but the end points of the line segment on the screen were based both on the offset 

of the same model. Now the visual end points are based on the model offset of the model where 

the respective part is from. 

Menus 

• Case 53565 

The 'Attached Loads Only' was displayed incorrectly in the entities panel. Fixed this. 

• Case 52402 

Text filters, as applied to object menus, would, at times, work the first time around but not if a 

different filter were applied subsequently in the same menu. This issue has now been fixed. 

• Case 49466 

When using the Workflows panel with more than one model it is usually the case that you need 

to choose the model to work on via a popup next to the button in question. This worked but it 

could: 

 

- Get left behind on the screen if the Workflows panel was unmapped. 

- Get left in the same position on the screen if the Workflows panel was moved or resized, 

instead of staying next to the button. 

 

Both problems, in fact not specific to workflows, have been fixed. 

Metal forming 

• Case 53780 

In the FLD panel when picking a single point from the FLD plot shells corresponding to all 

points could be labelled instead of only the shell corresponding to the picked point. This has 

been fixed. 
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Nastran 

• Case 52063 

Fixed a problem with reading in certain OptiStruct OP2 files which contained a large number of 

file records. 

Performance 

• Case 52548 

The reading of ascii groups files (.asc) and their conversion to binary groups files (.grp) worked 

correctly but it could become slow when a big model contained many groups. 

 

The logic has been recoded to make this many times faster, keeping the same functionality. 

 

In addition the optional Colour, Transparency, Blanking, etc. information that could be added to 

a group in an ascii file is now 'remembered' in the binary file. This means that the (new) only 

option in the groups menu can now also restore visual properties of the selected group if these 

are defined. 

Program crash 

• Case 50889 

D3PLOT has a database management system which tries to trade off the need to conserve system 

memory resources with the requirement for reasonable performance. This worked reasonably 

well on Linux but on Windows 10 it suffered from two problems: 

 

(1) Overall system page file usage ('virtual memory') was not reported or monitored. 

 

(2) The physical memory usage of this process was monitored correctly but changes in the way 

that Windows 10 handles memory meant that the various checks and balances were not working 

as intended. 

 

Memory monitoring has now been improved, and in particular virtual memory reporting has 

been restored. In addition, the database storage strategy for results has been tuned to make it 

cooperate better with Windows 10, meaning that the code is far less likely to halt with a 'cannot 

allocate further memory' error. 

Ptf compress 

• Case 47454 

Fixed an issue where ptfcut= was not working in tty mode. 

Quick pick 

• Case 53410 

Updated Quick Pick search bar in D3PLOT to accept more than 10 characters. 
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• Case 50251 

QuickPick key-in previously supported label ranges in the format '<label1> to <label2>' and 

'<label1>:<label2>'. It now also supports the format '<label1> - <label2>' to be more consistent 

with behaviour in PRIMER. 

Read 

• Case 53880 

D3PLOT would incorrectly display a model as harmonic data if the only shell data components 

in the file were the shell energies and thicknesses. 

• Case 53833 

For double precision models containing large IDs, PTF Cutdown files would be incorrectly 

written when outputting airbag particle data making them unreadable. This has now been fixed. 

• Case 53225 

D3PLOT could crash when reading a D3PART file if a ZTF file was also present in the directory 

and the model contained *DATABASE_CROSS_SECTION cards defined using both the _SET 

and _PLANE options. 

• Case 52119 

D3PLOT would often crash if a LS-PrePost database file (.db) that was > 2GB was opened. 

 

If D3PLOT failed to recognise the .db file, found an error in it or found something it didn't 

support then that could also cause D3PLOT to crash. These errors should now be trapped within 

D3PLOT and D3PLOT should now generate an error message and then continue. 

• Case 48326 

The 'Re-read Model' option in D3PLOT has been modified so that if a linked T/HIS session is 

running the re-read menu now displays an additional set of buttons that gives an option to 

automatically re-create any T/HIS curves for that model when the model is re-read. 

Selection 

• Case 49059 

The ambiguous menu, when triggered from the Measure tool, no longer displays the All button. 

'All' isn't appropriate in this context as the Measure tool typically expects selections to be made 

sequentially but one entity at a time - such as Node 1, then Node 2 for Node<->Node. 

Session 

• Case 53874 

D3PLOT crashes when trying to load session file from later versions. 

 

From version 21, an error is thrown rather than crashing, when trying to read a session file from 

later versions. 

 

D3PLOT and T/HIS now doesn't allow session files from later versions to be read in older 

program versions (applicable from version 21 onwards). 
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Settings file 

• Case 50997 

When adding a second model into a window that already contained a model the window could be 

drawn with the wrong shininess. This would generally result in a less shiny appearance than set 

in the Properties panel. This has been fixed. 

Text 

• Case 52365 

When there are multiple breaking characters in succession (whitespace, brackets etc...) if the 

cursor is placed within the middle of that set of breaking characters if you were to issue a 

Ctrl+Right then the cursor would only jump one space to the next breaking character instead of 

to the beginning of the first word to the right of it. This should now be fixed. 

User interface 

• Case 53448 

fixed colour of Read/Close buttons in the Model and Window panels for consistency. Also 

renamed all caps button texts to lower case texts (except for the first letter). 

• Case 53447 

fixed colour of Apply button on Traces panel for consistency. 

• Case 51598 

The Lighting panel would previously always appear docked on the right-hand side, but with a 

horizontal scrollbar at the bottom. Scrolling the panel would appear to just show empty space 

and two mostly obscured buttons. These two buttons were duplicates of the existing help and 

dismiss buttons on the panel, so they have been removed and the empty space and scrollbar are 

no longer present either. 

• Case 51558 

The threshold at which D3PLOT's Quick Pick undo stack will warn the user that it is using a lot 

of memory has been increased by a factor of 5 and the warning message in question has been 

clarified. 

There is also a new preference, <show_qpick_stack_warning> to control whether this warning 

popup will appear. If this is set to FALSE, the popup will not appear, and the Quick Pick undo 

stack will only be cleared on exiting the program. There is an option on the popup to set this 

preference for this behaviour. 

• Case 50353 

When using any of the Brightness, Theta and Phi sliders in the Material Attributes Panel, the 

preview sphere flickers. 

• Case 50174 

Prevented the HDF button from remaining active when the Read Equation menu is accessed via 

Edit Equation. 
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• Case 48385 

In the D3PLOT user interface the terminology slave and master for contact surfaces has now 

been renamed to surface A and surface B. 

User defined 

• Case 52704 

If a user created a user defined data component and then plotted 'MAX/MIN/MAG All' before 

plotting any individual integration point values, then when individual integration points were 

plotted the wrong values were displayed. 

Webgl 

• Case 52457 

Exporting annotations to D3PLOT Viewer could cause D3PLOT to crash if animations were 

exported and state selections were different for different annotations. This has been fixed. 

Workflows 

• Case 53401 

Confirmation question has been added if the user is overwriting a file when saving. 

Write 

• Case 53919 

If multiple models were loaded into D3PLOT and only a subset of them contained multiple on-

plan integration point data then the popup menu that allows the user to select between the 

following options 

 

Average at Centre 

All On Plan Points 

On plan pt #1 

On plan pt #2 

On plan pt #3 

On plan pt #4 

 

wasn't always available in the WRITE and XY-DATA menus. 

X-sections 

• Case 51977 

When on the cut section panel the option to display the section force summary was selected and 

the cut section was defined by constant X, Y or Z, then any changes to the defining coordinate 

value through the text box did not refresh the forces displayed. Now the forces update as 

expected when a new coordinate or node ID is typed or the coordinates for 'Origin and vectors' 

or 'LS-DYNA method' are changed manually. 
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Xy plot 

• Case 53549 

Sometimes Object Menus in D3PLOT contained an additional row that was labelled as 'unknown 

type'. 

• Case 48786 

In the XY-Data menu the option to specify the reference frame coordinate system wasn't always 

available for nodal data components (displacement, velocity, acceleration, temperature flux). 

 

If the user selected an element-based component and changed the coordinate system and the 

swapped back to a nodal component then the option was available. 
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2.3 T/HIS 

Airbag 

• Case 53822 

T/HIS would fail to read the ASCII version of the 'cpm_sensor' file if the file had been created 

using the L2A software or had been created by T/HIS from the LSDA/binout files. 

 

If a LSDA/binout file was read into T/HIS and it contained cpm_sensor data then the 'npart' 

(Number of Particles) data component wasn't available in T/HIS. 

Curves 

• Case 53037 

Fixed a problem with Graph.GetAllCurveIDs() and Graph.GetNumCurves() where it would 

sometimes report a curve is active on its respective graph after the curve had been deleted. 

Deleting 

• Case 48343 

Added additional 'every graph' options in the T/HIS curve manager for deletion of 'All Blanked' 

and 'All Visible' curves. Now, you can delete curves in the curve manager as if all graphs were 

flagged as active, even if they are not. The behaviour of the old buttons is retained with the 'in 

active graphs' buttons. 

Filename 

• Case 52116 

T/HIS now supports Vol 3 Keywords with long (9-16 digits) Part id filenames. 

• Case 51699 

When undocked, expanding the Read Data panel now also expands the Model title box (during 

Multi model select). 

Graphs 

• Case 53766 

When you dynamically view a graph (e.g. Mouse scroll zoom), then immediately delete that 

graph and then an Autoscale or redraw gets issued, T/HIS would sometimes crash. This has been 

fixed. 

• Case 53013 

On a high-resolution display, typically a laptop running at 3840 x 2200 so around 240 dots per 

inch (DPI), the lines in the T/HIS graphics window tended to look too thin when compared with 

the same plot performed on a standard display running at 96 DPI. This was because line widths 

were not scaled in proportion to display resolution. 

 

This is now fixed. By default, all the lines in the T/HIS graphics window (border, grid, curves, 
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etc) are now scaled with DPI. So, in the example above the scale factor would be 240 / 96 

meaning that the lines now have a pixel width roughly 2.5x thicker. 

 

This behaviour is controllable and can be switched off in the Display options panel, or by 

preference. 

Integration 

• Case 52994 

If a set of D3PLOT results were compressed with FEMZIP (jobname.fz) and then the LSDA 

/BINOUT files was renamed to 'jobname.binout0000' then T/HIS failed to find and open the 

BINOUT files when T/HIS was started via the D3PLOT=>T/HIS link. 

Javascript api 

• Case 53221 

In previous versions of T/HIS, clicking the 'Debug' button twice in the JavaScript menu could 

make the JavaScript debugger inoperable. This issue has now been fixed. 

• Case 52608 

When the JavaScript function Page.Layout() was issued with a non-global set of pages (e.g. 

single page number or 0), the position of the graphs on the main window was not being 

recalculated. This has now been fixed. 

Macro 

• Case 52540 

The example T/HIS Macro script 'to_g_c180.thm' that was included within the release package 

contained an extra line that shouldn't have been there and would generate an Error if the Macro 

was run. 

 

This can be fixed by editing the file and deleting the last line. 

• Case 52455 

When the environment variable SHOW_MACRO_BUTTON was set to true, the gGRPC/Python 

button in the 'Options' dropdown wasn't getting shown and working properly. This has been now 

fixed by pushing the Macros button to the end of the 'Options' dropdown. 

Menus 

• Case 53452 

The model selection menu in T/HIS - used to select a model from which entities can be edited in 

PRIMER - has been resized to make it more accessible. 

• Case 52306 

Fixed row highlighting on the Curve Table panel in T/HIS when left clicking a textbox. 
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• Case 48491 

If the user selected the option to search directories in one of the read menu options then the 

filename option in some of the other read menus was greyed out by mistake. 

Operations 

• Case 51856 

Fixed an issue in the CORA tool preventing the TMIN evaluation interval from working. 

Program crash 

• Case 53829 

If the automotive assessment workflow was run in a T/HIS session linked with D3PLOT, then 

T/HIS would crash when the automotive assessment window was closed. This has been fixed. 

• Case 52731 

T/HIS could crash when reading in a THF file if the ZTF file was also present and being read if 

the number of items in the THF was greater than the number of items in the ZTF file. This could 

happen in the case of Beam elements written to the Time History block if the option to 

automatically create 'dummy' beams in top of springs and dampers (the BEAM option on 

*DATABASE_BINARY_DPLOT) was left set to 0 (the default). 

Program hanging 

• Case 52616 

Fixed an issue where T/HIS could lock up while dynamic viewing when there's a curve that has 

been assigned to the Y2 Axis and Align Y=0 has been selected. However, because of this fix, 

manually typed in values for min and max on the Y-Axis while the Y2 Alignment option is 

active will once again be changed automatically (as it did in V19), prioritizing the alignment 

over what you have just typed in. 

Python api 

• Case 53832 

A new 'Constant' class has been added to the T/HIS API. 

Read 

• Case 52571 

Subsystem Inertia tensor rows, Principal inertia, Principal directions and Mass components were 

not being correctly read in for FastTCF. This has now been fixed. 

• Case 51837 & 51814 

If a COSIM analysis was run then 2 set of results files are generated in the same directory. The 

1st 'Main' model uses the default naming convention for all of the results files but the 2nd 

'Cosim' model prepends 'cs_' to all of the file names. 

 

In previous versions T/HIS would fail to associate all of the 'cs_' files correctly with the 'Cosim' 

model. 
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Selection 

• Case 43549 

When running the D3PLOT > T/HIS link the option to select SPCs in the T/HIS entities menu by 

interactively picking SPCs in the D3PLOT graphics window didn't work. 

T/his link 

• Case 52447 

The timeline in D3PLOT->T/HIS Link now updates correctly when the graph is in logarithmic 

mode. 

• Case 52174 

When T/HIS is linked with D3PLOT it normally runs 'docked' inside the D3PLOT user interface. 

However, it is possible to undock the entire T/HIS window or just its right hand side command 

bar. 

 

This did not work correctly on Windows if the desktop had multiple monitors and the primary 

monitor was not the left-most one. The undocked T/HIS window would come up in the wrong 

place, sometimes with its top above the top of the screen making it impossible to reposition it. 

 

This was because of the way desktop coordinates work on Windows: monitors to the left (or 

below) the primary monitor have -ve coordinates and the undocking logic was not considering 

this. Now fixed. 

User interface 

• Case 53859 

On some larger, high-resolution monitors (e.g. QHD screens), scrolling to the bottom of the list 

of points on the Curve Editor would sometimes fail to show the last few points. This has now 

been fixed. 

• Case 53823 

The following T/HIS curve operations have been added to the popup menus that hang off of the 

'Functions' button in the T/HIS Top bar. 

 

Automotive->CORA 

Automotive->MADM 

 

Operate->db 

Operate->dbA 

Operate->Octave 

Operate->Regression 

 

Maths->ATan2 

 

Seismic->IFFT 
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• Case 53790 

In the [Model] Read, Shell menu when extracting data for per integration point data (through the 

depth of the element) there is a further sub-menu which allows selection of in-plane integration 

point. Displaying this could cause the programme to get stuck in an endless loop with the panel 

'flickering'. 

 

This was caused by an internal error in the way the new size of the panel required to show the 

extra in-plane integration point selection buttons was processed. Now fixed. 

• Case 53672 

The CORA and MADM tools were not available as results when using the QuickFind search 

feature. This has been fixed. 

 

Additionally, selecting the Bessel Filter from QuickFind search results produced an error 

message instead of launching the tool. This has also been fixed. 

• Case 52909 

In the T/HIS user interface the terminology slave and master for contact surfaces has now been 

renamed to surface A and surface B. 

• Case 51603 

Question mark icon in popup window created by JS function (Window.Question('Title' 

'Question')) in T/HIS now has the same colour as in PRIMER/D3PLOT 

Variables 

• Case 48021 

Default variable names in T/HIS and D3PLOT are now prefixed with the item name from 

REPORTER. If the item name contains characters that are not supported in variable names, e.g. 

spaces, !, *, etc, these are replaced. 

Workflows 

• Case 53442 

The curves plotted of tibia compression for HIII occupants were the incorrect sign. This has been 

fixed. 

Write 

• Case 53848 

T/HIS now outputs accurate ISO-MME Units in accordance with the specifications outlined in 

the RED B ISO-MME Document, applicable to both ISO MME Version 1.6 and 2.0. 

• Case 53501 

The -iso_config command line option did not work if it used a relative path. This has been fixed. 

• Case 52430 

T/HIS ISO_MME Config file only supports certain keywords for objects. So, Added an error 

check for cases there is an incorrect keyword and T/HIS doesn't have any objects to read from 

the config file. 
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• Case 51979 

T/HIS can now read both strings and integer as an input for the id's in config file for exporting 

ISO-MME Output. 

Xy plot 

• Case 52499 

The white spaces in the data fields in csv are now treated as an empty field. 
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2.4 REPORTER 

Capture 

• Case 53551 

Enveloping for all windows was switched off if a new window was created, if a model was 

opened in a new window or added to an existing window or if a model was removed from an 

existing window or deleted. Now only windows affected by the change have enveloping 

switched off. 

Generate 

• Case 50750 

REPORTER now always shows the 'Generate' option in the context menu whenever you right-

click on selected item(s) in the template or report. REPORTER previously removed this option if 

any of the selected items do not change when generated. 

Help 

• Case 47090 

REPORTER opens HTML and PDF files to give you access to documentation and additional 

user guides. REPORTER now uses the same logic to open these files as PRIMER, D3PLOT, 

T/HIS and SHELL. This fixes an issue where PDF files sometimes failed to open on Linux. You 

can now specify your preferred HTML and PDF applications via the REPORTER preferences, 

html_application and pdf_application. 

Pages 

• Case 53107 

When importing a template or a report, REPORTER now lets you choose what happens with the 

incoming master page. You can merge the master page into your current master page, overwrite 

your current master page with the incoming one, ignore the incoming master page or cancel the 

import. 

• Case 52802 

Duplicating a page or copy-pasting an item will no longer change the new item's image filename 

to the default %DEFAULT_DIR%/%DEFAULT_JOB%_image00X.png. Instead, the new item's 

image filename will be derived from the original one. 

Preferences 

• Case 53402 

If any of REPORTER’s default generic fonts are unavailable on your machine, REPORTER will 

automatically attempt to substitute them with an alternative font within the same generic 

category. 
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• Case 49585 

The reporter*maximise preference now works not only for the main window, but also for the 

'Choose a Template' dialog and 'Choose a Page' dialog as well. 

Standard templates 

• Case 53485 

Fixed an issue preventing the LSTC HIII 50M Detailed v190217_beta dummy model from 

working with the US NCAP REPORTER templates. 

Text 

• Case 53462 

There is a small number of fonts available in REPORTER for which certain characters/symbols 

cannot be written to PDF. In this case, a warning will be recorded in the Logfile to inform you 

which font it is. 

• Case 51340 

Previously, when you opened a template or report that contained fonts that were unavailable on 

your system, you were prompted to select font substitutions. However, when you imported a 

page, you were not prompted, and REPORTER would revert any unavailable fonts to an 

arbitrary system font. 

 

REPORTER now asks you to choose font substitutions whenever you open templates or reports 

or import pages with unavailable fonts. A new option in the font substitution dialog allows you 

to remember your substitution choices and automatically make the same substitutions to future 

templates, reports and pages opened within the same REPORTER session. 

 

REPORTER now asks you to choose font substitutions whenever you open templates or reports 

or import pages with unavailable fonts. A new option in the font substitution dialog allows you 

to remember your substitution choices and automatically make the same substitutions to future 

templates, reports and pages opened within the same REPORTER session. 

• Case 50312 

Fixed an issue that could cause the titles of templates and pages in Choose Template and Choose 

Template dialogs to become truncated on buttons. 

User interface 

• Case 53584 

The 'Edit Template Properties' dialog box is no longer duplicating entries in the drop-down 

menus every time it is re-opened. 

• Case 53480 

The Choose Template and Choose Page dialogs now show the filename of the selected template 

or page next to the title and description. This can help clarify the location when multiple Library 

or Workflows locations have been specified in preferences. 
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• Case 47886 

Previously, drop-down menus on Linux would display top and bottom scroll arrows regardless of 

the size of the list, obscuring the item names. Now the drop-down list will be displayed without 

arrows, with item names fully visible. 

Variables 

• Case 52900 

When capturing from D3PLOT or T/HIS, the default names for the variables associated with the 

capture are now derived from their corresponding REPORTER Oasys item names. 

• Case 42430 

When opening the variables menu in a new template, the 'When generating save variables to 

directory' option will be disabled by default. This is to prevent frequent issues with autotable 

generation where it would save its own reporter_variables file and read from it. This change 

would not apply to existing templates that were generated with versions < 21.0. 
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2.5 SHELL 

General 

• Case 54039 

Previously, it wasn’t possible to submit a job using the option to create a BASH compatible 

submission script if the option to specify an MPI executable was used. This issue has now been 

fixed. 

Program crash 

• Case 53580 

There was a crash in the REPORTER batch panel while adding “Input Keywords”. This issue 

has been fixed. 

User interface 

• Case 53458 

On Linux platforms the logic for testing whether it is running on a remote server via a slow 

network has been modified: 

 

- The default round trip time threshold at which it reverts to 'simple' graphics has been increased 

from 1ms to 5ms 

 

- Previously this threshold was hard-wired, now it is configurable in the range 0 to 1000ms using 

new environment variable SHELL_THRESHOLD_RTT 

 

- A new information message is written to stdout when this threshold is exceeded which explains 

what is happening, giving times and also an explanation of what to do about it. 
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2.6 Oasys 

PDF 
• Case 50903 

Acroread has not been supported on Linux flavours for a few years now. We have now demoted 

the priority of Acroread when searching for a suitable program to launch PDFs on Linux 

machines. Issue now fixed. Evince and Okular are now the first two options that the program 

will try before reverting to other PDF readers and web browsers. 

Scripting 
• Case 51595 

A JavaScript using a GUI written from the GUI Builder would crash with an error if a widget 

had a double quote in its text or hover text. This has been fixed. 

User Interface 
• Case 53376 

When trying to double click some text on a textbox and a breaking character (characters like 

whitespace, parenthesis, etc.) was the first character on the string, the breaking character would 

incorrectly get highlighted. Problem is now fixed as follows: 

 

- Altered the behaviour of double clicking to the left of a breaking character. Previously, this 

would highlight the word to the left. However, it was expected that it should highlight the 

breaking character to the right of it instead. 

 

- Altered the behaviour of double clicking at the right most part of a textbox if there was a 

breaking character as the very last character on the string. Previously, nothing got highlighted. 

Now, the breaking character will be highlighted. 

• Case 47280 

Previously, Oasys Suite 20.0 (and earlier) applications were not DPI-aware. These applications 

would be sized correctly for the primary monitor on which they start but would be too big or too 

small when transferred to another monitor of a different resolution. This has been fixed. 

PRIMER 21.0, D3PLOT 21.0 and T/HIS 21.0 are now all ‘Per Monitor DPI Aware’ on 

Windows. 

This means that when a Windows desktop has monitors of different Dots Per Inch (DPI) values, 

typically when a high-resolution laptop is connected to a lower resolution monitor, the size and 

scale of an Oasys Suite 21.0 application (PRIMER, D3PLOT or T/HIS) will adjust itself when 

moved between monitors.  



Oasys Ltd LS-DYNA Environment Software Release Notes 

Version 21.0 
 

Ove Arup and Partners Limited | Final | May 2024  

 

Page 53 
 

3 Enhancements 

The enhancements and bug-fixes for each program have been broken down into a series of 
topics.  Within each topic enhancements and bug-fixes are listed by case ID. 

3.1 PRIMER 

Assembly 

• Case 50684 

Confirmation for overwriting file when writing part tree assembly files has been added.  

• Case 50173 

Added support for processing HyperMesh Components formed of *CONSTRAINEDs when 

reading in a LS-DYNA .key file containing HyperMesh comments (PRIMER only supported 

Components formed of *PARTs previously). 

Now, all $HMNAME COMPS, $HWCOLOR COMPS, and $HMCOLOR COMPS comments 

get preserved when read into PRIMER, and all *CONSTRAINED instances get added to their 

corresponding PRIMER groups and assemblies as listed in the $HMASSEM comment. 

Attached 

• Case 49421 

For the Attached → Constrained → Sub types panel, the ‘Dismiss’, ‘All on’ and ‘All off’ buttons 

at the top of the panel are now always visible, even after scrolling. 

Batteries 

• Case 53920 

Added a new tool to PRIMER called ‘Battery setup’ that is accessible through the ‘Batteries’ 

button from the Tools panel. It can be used to easily setup a pouch battery structure and combine 

it with relevant *EM_RANDLES cards to model Randles circuits within the battery. It can also 

automatically generate the necessary isopotentials and isopotential connections. It also offers the 

option to activate or create relevant analysis keywords. 

Belts 

• Case 52080 

The seatbelt shoulder slipring quick fit function now creates a 90-degree belt bend on the outside 

point, a 45-degree bend on the inside point, and a narrower span between the two updated points. 

• Case 51880 

Added a new feature to the seatbelt fitting tool that allows effortless path definition at an 

explicitly meshed pelvis slipring. 

• Case 51878 

Added an option to create *DATABASE_CROSS_SECTION for explicit Pelvis slipring. 
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• Case 51849 

Added a new ‘Automatic’ option for the belt_reference_geometry preference that would 

automatically turn on the ‘create reference geometry’ option in the Seatbelts ‘Mesh’ panel if an 

explicitly meshed slipring is detected in the model. Otherwise, this will be turned off. The new 

‘Automatic’ option is now the default belt_reference_geometry value. 

• Case 51720 

Added a file overwrite check for writing a seatbelt path to a CSV file. 

• Case 51592 

Update to seatbelt tapering: ensuring that seatbelt tapers to unskewed position at mid span and 

tapering between end point vectors when required. 

• Case 51577 

In the seatbelts tool, the ‘Accept’ button from the ‘Explicit Slipring’ panel is redundant (the 

general ‘Accept’ button in the ‘Fit’ panel can be used to save the updated path) and has been 

removed. Also greyed out the ‘Adjust’ button in the ‘Explicit Slipring’ panel because if it is 

clicked more than once, it will generate multiple points at the same locations. It will be 

reactivated if the ‘Undo’ button is pressed. 

• Case 51573 

For seatbelts, the list of editable points in the ‘Define path’ panel (from 10 to 19 points) has been 

expanded to make it easier for you to visualise and edit the data. 

• Case 50878 

Seatbelt fitting tool: The ‘Explicit Slipring’ panel can now be mapped using the ‘Slipring’ button 

in the path editor. 

• Case 50719 

Improved efficiency of shoulder slipring rotation during seatbelt fitting by decoupling it from the 

#Iter setting. Instead, you can select an Update frequency determining how often the shoulder 

slipring is rotated. Additionally, a Sensitivity slider has been added to the Shoulder slipring panel 

which can automatically turn the slipring rotation on/off as required during seatbelt fitting. 

• Case 48512 

Added an option for adding additional prefix text for *DATABASE_CROSS_SECTION created 

on seatbelt as per ISO standard. 

Also added an option to create *DATABASE_CROSS_SECTION for explicit slipring. 

Checking 

• Case 52853 

A check has been added to report multiple definitions of 

*BOUNDARY_PRESCRIBED_MOTION on the same node. 

• Case 51569 

If an include file name exceeds 80 characters, PRIMER will give a warning in the dialogue box. 

A new preference allows you to treat this as an error or ignore it altogether. 

• Case 51382 

The check LS-DYNA output tool now recognises shell entities for error INI+373. 
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• Case 50760 

Reporting duplicate seatbelt 2D as an error now. 

Clipboard 

• Case 52863 

New options have been added to control clipboard selection. Additional to existing selection of 

junior items and ‘missing’ items, optionally, you can now select sets from selected item(s) and/or 

propagate to senior items. 

Contour 

• Case 51497 

Added Viridis, Plasma, Magma and Inferno contour ramp colour options to the ‘Contour Level 

& Value Format Settings’ panel. A new primer*contour_ramp preference is also available to 

support this new feature. 

• Case 30409 

You can now choose between the following contour level options for PRIMER 21.0: 

- ‘Automatic levels’ (original behaviour) 

o A uniform distribution of level values. 

o Number of levels can be changed with the #levels slider. 

- ‘User-defined levels’ (new option) 

o Manually specify the level values. 

o Insert/delete levels with the popup buttons from the contour level value textboxes. 

o This option is not available for integer data components. 

Crash Test Setup 

• Case 49744 

For the Crash Test Setup tool, added a new barrier setting component in the ‘Check Nodes’ 

window that allows choosing between two methods for automatically configuring the positioning 

nodes on the barrier. You can choose the default option that selects the lowest corner nodes of 

the barrier front face (old method), or a newly implemented option that creates external nodes at 

the intersections of the lowest edges of the barrier front face. The latter option can be useful for 

barrier models with curved lower corners, providing more accurate positioning results. 

Cut Section 

• Case 50988 

Added two new properties to the cut section properties panel: 

- Fully plastic equal force axes in global coordinates (Xf_g, Yf_g, Zf_g), and  

- Equal area axes in global coordinates (Xe_g, Ye_g, Ze_g). 

Also changed the labels of the centroid global coordinates from (Xg, Yg, Zg) to (Xc_g, Yc_g, 

Zc_g) for consistency. 
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• Case 50931 

For multiple parallel cut planes with uniform spacing, there are now two separate text boxes for 

the numbers of positive and negative planes instead of one less intuitive text box for both. 

• Case 50758 

Previously on the cut section custom spacing panel, positions were sorted immediately after 

editing them. This seemed unintuitive when many positions were edited after each other. In 

PRIMER 21.0, the positions now remain where they are until the new ‘Sort positions’ button is 

clicked, or the panel is closed and reopened. 

• Case 50535 

New methods have been added to the CrossSection class in the PRIMER JS API: 

CrossSection.Autosize() and CrossSection.CreateAlongFeatureLine(). 

 

CrossSection.Autosize() is a member function that will alter the size of the 

*DATABASE_CROSS_SECTION such that it is just big enough to cut through all elements in 

that plane (limited to the Part Set, PSID, if set on the cross section) plus an additional percentage 

scale to ensure cuts at the edge of the plane are not missed due to floating point precision, as well 

as centring the cross section on all of the cuts. The additional percentage scale can be altered by 

providing it as an optional argument, otherwise, the function uses the default value which can be 

controlled by the preference primer*cross_section_auto_size_percent. 

 

CrossSection.CreateAlongFeatureLine() is a class function which creates a series of 

*DATABASE_CROSS_SECTIONs along a free edge or feature line starting at a specified node. 

The number of cross sections, and their pitch, can be specified as arguments. This function also 

has the option to autosize the cross sections. 

 

Furthermore, two new optional arguments have been added to the _PLANE version of the 

CrossSection constructor: autosize, and autosize_pct. These arguments control whether the new 

*DATABASE_CROSS_SECTION will be autosized or not. 

Dummies 

• Case 52610 

The HBM visualisation entities can now be loaded and viewed in D3PLOT as well. 

You can create a groups file (*.vis) from HBM visualisation table in PRIMER and load this 

groups file into D3PLOT via the groups tools menu. 

You can view the HBM entities based on PRIMER assemblies, or based on the HBM anatomy, 

or both. 

• Case 49413 

A new WRITE_DUMMY_ANGLE dialog command is added to write out a Dummy Angles File 

through Command-line mode. 

• Case 48515 

For the ‘Position parts’ → ‘Move points’ option in the Dummy/HBM panel, the restriction of 

Node selection (from only one PRIMER model that the Dummy is in) for the ‘Move to node’ 

option is now relaxed so that you can select/pick a node from any of the open models in the 

session. 



Oasys Ltd LS-DYNA Environment Software Release Notes 

Version 21.0 
 

Ove Arup and Partners Limited | Final | May 2024  

 

Page 57 
 

Edit 

• Case 49960 

Added an editing panel for keyword *CONTROLLER_PLANT. 

• Case 41957 

It has always been possible to open multiple editor panels on the same entity in PRIMER and 

these do not conflict since each works on its own definition. However, if subsequently, the entity 

is updated from both panel A and panel B, the one which is updated later will supersede any 

changes made earlier, leading to possible confusion. 

 

To guard against this, PRIMER 21.0 now detects the 2nd and subsequent editing panels opened 

on an entity, and these are configured in ‘browse’ mode which only gives read access to the data. 

This is configurable in the ‘Options’ → ‘Panel behaviour’ menu, and also by preference, where 

the old behaviour can be restored if desired. 

Element Quality 

• Case 51068 

Setting the ignore_null_part_element_checks to FALSE or unticking the ‘Ignore null elements’ 

tick box in the ‘Check options’ panel will now ensure that Null elements are displayed in 

element quality contour plots. 

Encryption 

• Case 49976 

When an incompatible key is selected for output version, a warning is now thrown in the 

encryption tool. 

Favourites 

• Case 51605 

When selecting from existing Tools or Keywords to add to your Favourites, the options are now 

displayed in a tree widget. This provides a better representation of the existing button hierarchy 

and more consistent support for non-ASCII characters in button names. It is also now possible to 

use Shift + left-click to select a run of contiguous buttons in the widget. 

• Case 51208 

The limit on the maximum number of buttons that can be supported by the Favourites menus has 

been increased to 100 (up from 20 in PRIMER 20.0). 

Graphics 

• Case 53838 

PRIMER labels are now displayed against a background in order to make the label text more 

legible. This background can, optionally, be turned off either from Display Options → Text & 

Labels → Label Background drop down, or by setting the preference primer*label_background. 
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JavaScript API 

• Case 52541 

The argument list for the CrossSection constructor was very long and contained many optional 

arguments, making it impossible to define one of the later optional arguments without also 

defining the earlier ones. To simplify the constructor, the argument list has been deprecated in 

favour of a new argument list: model and option (cross section type) as before, and a third 

argument in the form of an object, the properties of which define the arguments that could be 

found in the deprecated list. There are also additional properties in the object argument to control 

autosizing of _PLANE type cross sections. 

• Case 51844 

Some classes (Joint, JointStiffness, CoordinateSystem, Curve, HexSpotweldAssembly, Vector 

and InterfaceSpringback) in the PRIMER JavaScript API used to have multiple constructors. To 

simplify things and to make sure the Python API constructors for these classes work properly, 

old constructors have been deprecated and a new constructor that has only 2 arguments has been 

added for each class. In the new constructors, the first argument is the model, and the second 

argument is an object that has various properties. For details, refer to the new PRIMER 

JavaScript reference manual. 

• Case 51447 

Graticule-related improvements: 

1. A new preference for graticule mode has been added 

2. ‘Save display settings’ in the Display options panel will now save all the graticule 

preferences to the oa_pref file 

3. Logic to override tick_XYZ_auto when 3D tick interval preferences are manually set has 

been added 

4. Graticule plane colour option and transparency option are now greyed out for 2D 

graticule mode (similar to D3PLOT) 

5. Option to turn graticule ON/OFF has been added to the list of shortcuts available via 

dropdown in shortcuts menu (has been added for both PRIMER and D3PLOT) 

• Case 49966 

Added JavaScript API support for *FREQUENCY_DOMAIN_RANDOM_VIBRATION 

keyword (class FreqVibration). 

• Case 43881 

Added JavaScript API support for *DAMPING cards: 

− Added class functions for the following keywords: 

o *DAMPING_FREQUENCY_RANGE 

o *DAMPING_PART_MASS 

o *DAMPING_PART_STIFFNESS 

o *DAMPING_RELATIVE 

 

− Added object type for the following keywords: 

o *DAMPING_MODAL 

o *DAMPING_STRUCTURAL 
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Keyword Editor 

• Case 49484 

Added a new feature to the keyword editor to be able to drag the edge of the field headers to 

make them wider (or shorter if needed). 

Also enabled double-clicking on the edges to auto-fit the particular column to the left based on 

the length of entries in the data fields. 

Added two new buttons below the ‘Single Row Format’, one to autofit all the columns, and the 

other to reset the column widths to the default widths. 

Labels 

• Case 16980 

Controls in the ‘Display Options’ panel to adjust the size of text in the graphics window have 

been updated to behave in the same was as in D3PLOT and T/HIS. This means a specific point 

size can be specified for the text which will not scale if the graphics window is resized. An 

‘Automatic’ option is still available to display scalable text. This can be applied to entity labels, 

model titles, the text shown with the contour bar, etc. 

 

Preferences primer*label_pt_size, primer*contour_text_pt_size and primer*title_date_pt_size 

have been added to support this, and the existing primer*label_size, primer*date_size and 

primer*contour_text_size preferences are now considered deprecated. They will still be read in, 

but it is recommended for you update to using the new preferences. 

 

Similarly, options for LABEL_PT_SIZE, TITLE_DATE_PT_SIZE and 

CONTOUR_TEXT_PT_SIZE have been added to the JavaScript API, and the existing 

LABEL_SIZE, DATE_SIZE and CONTOUR_TEXT_SIZE options are now considered 

deprecated. 

Mass 

• Case 51609 

If assign mass calculations complete without error, the assign mass → recalculate tool will now 

print to the dialogue box (not a listing box). 

• Case 50549 

The mass properties tool now supports the selection of material,section, hourglass, etc. It will 

find the referenced parts and calculate mass for them. 

Measure 

• Case 50783 

Picking of nodes on line using the ‘free edge’ option on object menus has been improved so that 

nodes on feature line can be selected when both initial picks fall on the feature line. The same 

applies when nodes on line are being picked for measure. 
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Mechanism 

• Case 52835 

A popup option for the ‘Lock’ button is added in the Tools → Mechanism → Position → 

Connection list panel, that opens a popup menu to Lock All/Unlock All Connections with a 

single click. 

Menus 

• Case 52845 

Object menus in PRIMER will not automatically auto-expand or auto-undock anymore. This 

behaviour can be controlled by the primer*menu_expand preference. 

 

The ambiguous pick menu for PRIMER (previously auto-populated while screen picking in an 

area containing a cluster of entities) will also no longer map automatically, except for composite 

plies. Again, relevant behaviour can be controlled using the preference 

primer*query_ambiguous. 

Mesh 

• Case 33534 

Added a new Solid Split feature ‘Split and Propagate’. 

 

Splits the solids from the selected face and propagates the split through the solid. Three types of 

splits are provided: 

1) Split both axes - splits the face by mid edges from all sides. 

2) Split with one axis - splits face by mid edges from one pair of opp. sides (only hexas) 

3) Split direction normal to the face - splits solid in the third axis normal to the face. 

 

A ‘Grow out face’ option is available in Multi Select with similar functionality as in Coat 

function, with ‘Break angle’ to control the selection growth. 

 

Added a ‘Visible only’ option to control the propagation up to visible solid elements, if required. 

 

Also added an ‘Align’ button to align the selected elements in the same orientation. This feature 

might be useful when splitting with option ‘Split with one axis’ when the individual elements are 

in different orientation. 

Model Build 

• Case 52048 

The model build tree and the template panel now red-light components where the file referenced 

does not exist. Hover text gives the full path name. 
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Model Modified 

• Case 51767 

When modified (red-lit) includes are written to an incremented name (i.e. not overwritten) they 

are now marked with a dark grey background. 

The dark grey background is removed after the master file is written. 

Nastran 

• Case 50485 

Nastran write out improvements: 

1. Added checks on length of beam element or orientation vector 

2. Declashing labels on writing out NASTRAN format 

3. Switching on ‘Convert tied contact to RBE3’ by default 

4. Cleaning up RBE2 and RBE3 elements 

5. Translating *MAT_057 to *MAT1 

6. Creating PBUSH property to accompany CBUSH element for *MAT_067 

7. Restraining all 6 DOFs for RBE3s for SHELL_EDGE_TIED_CONTACT 

8. Added an option to convert rigid parts into CONM2 elements 

9. Added an option to correct stiffness when using *MAT_ARUP_ADHESIVE 

10. RBE2 will now be written out in wide format correctly 

11. Added an option to autofix ‘Node is on another nodal rigid body’ on write out 

12. *CONSTRAINED_INTERPOLATION translated to RBE3 correctly 

13. Improving DOF constraint when RBE3 ties beam node in Nastran output 

• Case 50055 

PRIMER can now read in NASTRAN’s PLOAD2 card. It is converted to *LOAD_SHELL 

keyword inside PRIMER. 

Orient 

• Case 52395 

A new option has been added to orient whereby the orient of a node will move any constraint to 

which that node belongs, e.g., NRB, JNTC, CONSTRAINED_EXTRA_NODE(SET). 

• Case 51404 

PRIMER now stores nodal coordinates in 64-bit double precision (DP), and all transformation 

arithmetic on coordinates is also carried out in DP. In summary, this means: 

 

- Nodal coordinates are now stored to roughly 16 decimal digits of precision. The 16th digit is a 

little unreliable so rounding to 15 digits is the default for output. 

 

- Transformation calculations such as *INCLUDE_TRANSFORM, *NODE_TRANSFORM, 

*PART_MOVE and all internal Orient operations are now carried out at full DP resolution. 

 

- Keyword input and output of nodal coordinates now uses the full width of the 16 characters 

wide data field in small and I10 formats. This means that nodal coordinates are typically written 

out at 12 or more decimal digits of precision once exponents and minus signs are considered. 
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- In 20 characters wide fields used in the large format, the default is to round nodal coordinate 

output to 15 significant figures. 

 

- In all cases, this precision can be controlled by you. 

 

Testing suggests that memory consumption for a typical model will increase between 3% and 

5% due to the extra storage required. There has been no measurable effect on the overall speed 

of the code. 

Parameter 

• Case 51471 

Previously, PRIMER did not permit parameter names to start with ‘_’, only the letters ‘A-Z’. 

This was an oversight. Parameters with names staring with ‘_’ can now be used. 

• Case 51227 

The *PARAMETER edit panel can now be opened from the part tree. 

Part Table 

• Case 50812 

If part material is latent (defined but missing) or has undefined density, the CofG calculation will 

be performed for the part table using unit density. 

Part Tree 

• Case 51487 

The *SET_PART_TREE keyword can now be visualised in the part tree. 

Pedestrian 

• Case 50479 

Support has been added for the GB 24550 202X protocol in the Pedestrian Markup tool. 

Quick Pick 

• Case 36916 

*ICFD_PART and *ICFD_PART_VOL are now available in Quick pick and for visual selection 

in object menus. 

Read 

• Case 50154 

BROWSE MISSING INCLUDE FILE → APPLY TO ALL has been enhanced so that files 

where the format has been externally modified will be found. E.g., the referenced include may be 

‘fred.k’ but the on disk file is ‘fred.kby’ (converted to binary) or ‘fred.kby.zip’ (converted and 

compressed). 
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Renumber 

• Case 52588 

A new option ‘relabel all to next free range’ has been added on the renumber selection panel 

which will allow you to keep the labels of the selected items in continuous range(s).  

Additionally, the ranges displayed on the renumber selection panel have been corrected for the 

‘relabel item to next free’ option.  

• Case 50688 

A dialogue message is now printed when post renumber declash has occurred from the visualise 

panel. 

Scripting 

• Case 51022 

The new Closures Setup Tool has been added to the JavaScript menu. This tool is designed to 

control the position of a model via a *PARAMETER. The intended application of this is for 

vehicle closures (e.g., bonnets, doors, tailgates). 

Text 

• Case 51663 

Updated headers in excel file produced by contact → write to be consistent with master slave 

terminology changes. 

User Interface 

• Case 52161 

Added axes labels processor ID and time to load profile, contact profile, and message profile. 

Also added labels processor ID, no. of elements, type, and value to show its respective values in 

their textboxes while hovering over the graph. 

• Case 51180 

A quick way to change the background colour was introduced by adding a ‘Swap Fore/Back’ 

button under Display menu (Display → Swap Fore/Back). Clicking this button swaps the 

background and foreground colours of the graphics area. 

This is also added as one of the options in the Programmable Shortcut Keys list, which can be 

assigned to any of the desired keys. 

Volume III 

• Case 53869 

The sketch functionality is now available for *EM_ISOPOTENTIAL. 
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Workflows 

• Case 53137 

The workflow definition filename written to the workflow user data now uses a 

$OA_WORKFLOW variable to substitute the path to a workflow in a user-defined directory set 

with the oasys*workflow_definitions_directory and workflows in the OA_INSTALL directory. 

• Case 53060 

The version, build number, and name of the program used to write out workflow user data is now 

written to the user data. 

 

They can be read from the data using the JavaScript API Workflow functions:  

- Workflow.ModelUserDataVersionFromIndex(),  

- Workflow.ModelUserDataBuildFromIndex(),  

- Workflow.ModelUserDataProgramFromIndex() 

• Case 52927 

A new preference oasys*workflows_user_data_directory_name has been added to specify the 

name of a folder to search for workflow user data in. 

 

For example, if it is set to ‘my_workflow_user_data’, then in the folder structure below, the 

models in folder3 and folder4 will use the user_data.json file in 

folder1/my_workflow_user_data: 

 

- folder1 

| - my_workflow_user_data 

|  | - user_data.json 

| 

| - folder2 

|  | - model1.key 

|  | - user_data.json 

| 

| - folder3 

|  | - model2.key 

| 

| - folder4 

|  | - model3.key 

• Case 51729 

When a model is opened in PRIMER, D3PLOT or T/HIS, the model directory is scanned to look 

for any workflow JSON user data files for that model. This has been extended so it will now scan 

parent folders as well. 

 

This makes it possible to have one JSON user data file that can be used for multiple models 

(previously you had to have a copy of the JSON file in each model directory, which made it hard 

to maintain if you wanted to update the data). 
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For example, in the folder structure below, the user_data.json file in folder1 will be used for the 

models in folder3 and folder4, and the user_data.json file in folder2 will be used for the model in 

folder2: 

- folder1 

| - user_data.json 

| 

| - folder2 

|  | - model1.key 

|  | - user_data.json 

| 

| - folder3 

|  | - model2.key 

| 

| - folder4 

|  | - model3.key 

The preference oasys*workflow_max_upward_folder_search_depth can be set to control the 

number of parent folders that are searched. The default is 4. 

Write 

• Case 51643 

When rounded output format is used, results are rounded to the nearest value. When a value is a 

‘tie’ lying exactly between upper and lower candidates (e.g., 2.5 between 3.0 and 2.0) PRIMER 

rounds away from zero. 

 

The IEEE 754 standard give two options for this ‘tied’ case when writing decimal values: 

 

- Round to even (default) 

- Round away from zero 

 

So technically PRIMER is IEEE 754 compliant, but in practice this means that when comparing 

rounded output from PRIMER with the same output from other codes using standard libraries, 

there may (rarely) be a difference at the last significant figure for tied values. This can present a 

problem in a workflow which uses a tool like ‘diff’ to compare output files. 

 

As part of the double precision upgrade in PRIMER 21.0, it is now possible to choose between 

the two rounding methods. 

X-sections 

• Case 51606 

The ‘Renumber’ option is now available for *DATABASE_CROSS_SECTION cards. These 

cards can now be renumbered. 
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3.2  D3PLOT 

Annotation 

• Case 50421 

Added in the ability to increase and decrease the text size for the Annotation Playback title and 

description as well as adding a slider for very long descriptions and titles. 

 

Also added the option to save this text size as a preference. 

Contour 

• Case 51644 

Contour Options 'Levels' tab: 

- Added improved logic to set the text colour of contour level indices on the contour level 

buttons to be white or black depending on how dark or light contour level colour is. 

- Added colons to 'Format', 'Exponent' and 'Dec. Places' 

• Case 51626 

The 'Convert to log scale' button from D3PLOT 20 has now been replaced with a radio button 

for linear or logarithmic interpolation. This can be used for all Auto contours, Max + Min as well 

as the new automatic completion for User defined contours. This makes it easier to switch back 

to linear contours without losing intermediate values. 

 

Also, the log scale was only available between two positive numbers in D3PLOT 20. In 

D3PLOT 21 it is also calculated between two negative numbers in the same way, whereas 

between numbers of opposite sign or zero there are levels close to zero added automatically. 

• Case 51445 

In D3PLOT 21.0, a new 'Reset Colour' button has been added to the popup colour panel (when 

initialised from a contour bar level) so that the contour level colour can now be reset to the 

default colour specified by the current contour ramp option. 

• Case 49927 

For user-defined contours the level values needed to be defined all explicitly. Now new tick 

boxes for each intermediate level have been added to switch between explicit definition and 

values calculated by linear interpolation. 

 

Also the first or last level can be left open so that it is populated with the minimum or maximum 

across the whole model. 

• Case 26317 

In addition to the existing contour modes 'Auto all frames', 'Auto each frame', 'Max + Min' and 

'User defined' there is now a new option 'Auto all windows'. If this is selected for multiple 

windows, all these windows will get the same minimum and maximum on the contour bar, which 

are the extremal values across all these windows. 
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Cut section 

• Case 52437 

When PRIMER and D3PLOT are linked across the integration, there are now the following 

improvements: 

 

With multiple cut plane directions, a change of the currently selected direction in one program 

will also be transferred to the other program. 

 

When a cut plane is dragged in one program, the dragging is now also activated in the other 

program. This means that only one Drag button needs to be toggled to enable dragging in both 

programs. 

• Case 50932 

For multiple parallel cut planes with uniform spacing there are now two separate text boxes for 

the numbers of positive and negative planes instead of one less intuitive text box for both. 

• Case 50759 

On the cut section custom spacing panel in PRIMER 20 positions were sorted immediately after 

editing them. This seemed unintuitive when many positions were edited after each other. In 

PRIMER 21 the positions now remain where they are until the new 'Sort positions' button is 

clicked or the panel is closed and reopened. 

Deform 

• Case 44868 

In D3PLOT 21 a new option “Freeze Coordinates” has been added to the DEFORM menu. This 

option can be used to display the results from any state on top of the deformed geometry from 

another state. 

 

This option is similar to using Magnify with the magnification set to 0.0 to display results on a 

fixed geometry but unlike Magnify this option can be used to fix the geometry at any state 

within the analysis. 

Dummies 

• Case 52060 

The HBM visualisation entities can now be loaded and viewed in D3PLOT also. 

You can create a groups file (*.vis) from HBM visualisation table in PRIMER and load this 

groups file into D3PLOT via the groups tools menu. 

You can view the HBM entities based on PRIMER assemblies, or based on the HBM anatomy or 

both. 

Graphics 

• Case 53839 

D3PLOT labels are now displayed against a background in order to make the label text more 

legible. This background can, optionally, be turned off either from Display Options > Label 

Options > Label Background drop down or by setting the preference d3plot*label_background. 
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Javascript api 

• Case 52435 

In the new D3PLOT JS API there is a 'Node' class, which has an 'Elements' member function to 

find elements using that node. 

• Case 51269 

In the new D3PLOT JS API there is a 'Model' class, which allows reading models. 

• Case 48914 

In the new D3PLOT JS API there is now a Material class. 

• Case 48825 

In the new D3PLOT JS API there is a 'GraphicsWindow' class, with a 'SetModelInfo' method, 

which allows to change the colour of a model and of the title. 

• Case 48000 

The new D3PLOT JS API has a 'Part' class, which has an 'elementType' property. 

• Case 47999 

In the new D3PLOT JS API there is a 'Group' class. 

• Case 40873 

In the new D3PLOT JS API there is a 'Model' class, which allows reading/deleting models. 

• Case 40868 

In the new D3PLOT JS API, the Node, Shell, Solid, etc classes have a GetFromID method which 

will return null if entity does not exist. 

• Case 36792 

It is now possible to get the number of through thickness integration points for a given shell or 

tshell. In the new D3PLOT JS API there is a 'Shell' and a 'Tshell' class with 'integrationPoints' 

property. 

• Case 30615 

In the new D3PLOT JS API there is a 'Model' class and a 'GraphicsWindow' class, which allow 

reading/deleting models and to add/subtract them in graphics windows. 

• Case 27377 

In the new D3PLOT JS API it is possible to convert from external ID to internal ID, as Node, 

Shell, Solid, etc classes all have a label and index property. 

• Case 20100 

There is now a Model class in the new D3PLOT JS API. 

Local axes 

• Case 29881 

In the Entities menu there are new options in version 21 that control the size and display 

Element, Material and Ply local axes. 
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These options include the ability for the symbols to be sized automatically by D3PLOT based in 

the element dimensions or to use a fixed size for all elements. 

Materials 

• Case 50010 

From version 21 onwards D3PLOT will now display the local material axes triads on elements if 

D3PLOT can find and read a ZTF file generated by PRIMER. 

 

As well as displaying the triad using the normal symbol with X, Y and Z axis labels new options 

have been added to speed-up the display that will display a coloured triad (without labels) or just 

the local X, Y or Z axes. 

Menus 

• Case 52059 

Object menus in D3PLOT will not automatically auto-expand or auto-undock anymore. This 

behaviour can now be controlled by the d3plot*menu_expand preference. 

The ambiguous pick menu for D3PLOT (previously auto populated while screen picking in an 

area containing a cluster of entities) will also not automatically map anymore (except for 

composite plies). Again, the relevant behaviour can be controlled using the preference 

d3plot*query_ambiguous. 

• Case 53587 

When entities are screen-picked, the screen pick menu is auto-populated and gives you further 

information about the entities picked. This menu also includes options to refine picking and can 

be explicitly invoked by clicking 'Vis' in any PRIMER-style object menu. 

 

The 'Vis' (screen pick) menu has been redesigned to make various options more accessible and 

intuitive. Buttons have been reorganised, icons introduced, and hover text added 

 

This menu can now, optionally, be made a floating menu by setting the preference 

d3plot*vis_menu_position and giving it the value 'FLOATING' 

Nastran 

• Case 51665 

When an OP2 file is read into D3PLOT, any RBE2 definitions are now translated into separate 

NRBCs instead of being converted into rigid beam elements. 

 

RBAR definitions in the OP2 file are still translated into rigid beams. 

Part tree 

• Case 52733 

Performing an ONLY operation on Groups from Part Tree will now restore the visual attributes 

of the selected group, if defined. 
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Session 

• Case 42520 

A bookmarks tool has been added to D3PLOT allowing fast capture and reloading of page 

views. Bookmarks can be accessed via the TOOLS menu. Bookmarks can be captured using a 

new icon on the top bar. 

Shortcut 

• Case 51667 

A 'Swap Fore/Back colour' shortcut key is added under Programmable shortcut keys list in 

D3PLOT and THIS, which can be assigned to any user desired keys and used to swap the 

foreground and background colours. 

Views 

• Case 49891 

A new preference 'initial_view_orientation' for PRIMER and D3PLOT accepts the eight pre-

programmed views (+XY, +YZ, +XZ, -ISO, -XY, -YZ, -XZ, -ISO) as its value. 

 

The preference sets the initial view of the graphics window in which PRIMER and/or D3PLOT 

opens. It also sets the dialogue command 'ZERO_VIEW' to the specified view. 

 

-oasys*initial_view_orientation (For both PRIMER and D3PLOT) 

-primer*initial_view_orientation (For PRIMER) 

-d3plot*initial_view_orientation (For D3PLOT) 

Webgl 

• Case 53035 

Added the new contour range label and the envelope plot label to D3PLOT Viewer export. 

Workflows 

• Case 52421 

The workflows menu has been split into two tabs: 

 

- Defined Workflows - shows workflows that have the required data and can be run in D3PLOT 

- Undefined Workflows - shows workflows that can be run in D3PLOT, but don't have the 

required data. 

 

Selecting a workflow in the Undefined Workflows tab opens the model in PRIMER and starts 

the workflow to select the required data. 

 

A window also opens in D3PLOT where you can update the workflow menu when the data has 

been saved. This will move the workflow to the Defined Workflows tab so it can then be run in 

D3PLOT. 
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• Case 51150 

The WorkflowDefinitionFilename() and WriteToFile() methods that exist on the Workflow class 

in PRIMER have been added to the Workflow class in D3PLOT and T/HIS. 

 

  



Oasys Ltd LS-DYNA Environment Software Release Notes 

Version 21.0 
 

Ove Arup and Partners Limited | Final | May 2024  

 

Page 72 
 

3.3 T/HIS 

Javascript api 

• Case 53507 

T/HIS and D3PLOT can now return build number when Utils class Build() method is called in 

JS script. 

Operations 

• Case 51286 

In T/HIS CORA, when you click Calculate, corridor and cross-correlation graphs are now 

created automatically with rating information provided in the legend and graph title as 

appropriate. 

Performance 

• Case 50157 

Four new functions have been added to the JavaScript interface in T/HIS that can be used to 

speed up scripts that generate a lots of graphs and curve manager updates. 

 

The 1st pair enable and disable some menu updates. 

 

EnableMenuUpdates(); 

DisableMenuUpdates(); 

 

At the moment these calls are limited to the curve manager, curve table, read menu and entity 

selection menu. 

 

The 2nd pair of calls 

 

EnableGraphWindowUpdates(); 

DisableGraphWindowUpdates(); 

 

enable/disable the graph redraw logic that normally gets called whenever the contents or setting 

in a graph are modified. 

Read 

• Case 53866 

When reading data from THF (d3thdt) files from a network disk T/HIS could be considerably 

slower than a local disk and the performance could be affected further on a system with high 

latencies. 

 

To improve the performance the internal buffer size inside T/HIS has been increased from 512 to 

2048 Words as this has been found to be faster on all the systems it has been tested on. 

 

On some systems increasing the buffer size further could improve performance so a new 
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preference: 

 

this*file_buffer_size 

 

and Environment variable 

 

THIS_BUFFER_SIZE 

 

have been added which can be used to set the buffer size between 512 and 1048576. 

Workflows 

• Case 52422 

The workflows menu has been split into two tabs: 

 

- Defined Workflows - shows workflows that have the required data and can be run in T/HIS 

- Undefined Workflows - shows workflows that can be run in T/HIS, but don't have the required 

data. 

 

Selecting a workflow in the Undefined Workflows tab opens the model in PRIMER and starts 

the workflow to select the required data. 

 

A window also opens in D3PLOT where you can update the workflow menu when the data has 

been saved. This will move the workflow to the Defined Workflows tab so it can then be run in 

T/HIS. 

• Case 51697 

T/HIS now supports ISO-MME Version 1.6 Export according to Euro NCAP Virtual Testing 

Protocol. 

You can now add operations in ISO-MME Config file to operate on existing curves and do 

required operations to get to the required output according to your ISO Code. 

The ISO-MME Export can now Display Units in Data File(.001,.002 and so on) based on Units 

defined by the user. 

T/HIS now supports descriptor option in Test Data Block, Objects Block, Channel Block and 

Operation Block which can be used to define any additional property to be displayed in (Test 

File(.mme), Object File(.mmi), Data File(.mmd,.001)). 

• Case 51060 

Added Display Unit options for Pulse Index and Energy Check Workflows 

• Case 50690 

Oasys 21 includes several new Workflow tools to support Virtual Testing and, in particular, the 

Euro NCAP Virtual Far Side Simulation & Assessment Protocol Version 1.0. The new tools are: 

 

1. Automotive Assessments 

The Automotive Assessments Workflow includes support for the Euro NCAP VTC protocol. 

 

2. LS-DYNA to ISO-MME 

A new tool to convert LS-DYNA results into the ISO-MME format as specified by the Euro 

NCAP VTC protocol. 
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3. SimVT 

A new, powerful tool for correlating simulation versus test curves, or indeed any combination of: 

LS-DYNA models, ISO-MME data and CSV data. Supports the Euro NCAP implementation of 

the ISO/TS 18571 rating method. 

 

4. Euro NCAP VTC Quality Criteria 

A new, convenient tool for assessing the quality criteria specified in section 6.1 of the Euro 

NCAP VTC protocol. 

 

5. Euro NCAP VTC Videos 

A new, convenient tool for creating the videos specified in section 5.2.1 of the Euro NCAP VTC 

protocol. 

• Case 50417 

Updates to the Energy Check Workflow Tool allowing users to visualise different energies of a 

model and perform checks. 
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3.4 REPORTER 

Frequency 

• Case 51591 

A new script has been added for Library Program items to extract eigenvalues (modal 

frequencies) from LS-DYNA's eigout file. The script creates REPORTER variables, allowing the 

eigout results to be tabulated in a report. The following library templates and pages are now 

provided: 

 

- Eigout_Table_A4_Portrait_Layout.orp 

- Eigout_Table_PowerPoint_Layout.orp 

- Eigout_Table_A4_Portrait_Layout.ort 

- Eigout_Table_PowerPoint_Layout.ort 

Pdf 

• Case 52154 

PRIMER, D3PLOT, T/HIS, and REPORTER now warn you if the PDF and HTML applications 

you have set via the oasys*pdf_application and oasys*html_application preferences, 

respectively, are not valid. 

Pages 

• Case 50875 

REPORTER now features enhanced page navigation functionality with the introduction of a new 

page navigation toolbar. Page thumbnails are displayed for the current template or report. Using 

this page navigation toolbar, you can navigate between pages by clicking the relevant page 

thumbnail. Right-clicking the page thumbnails allows you to execute context menu actions such 

as deleting, duplicating and adding pages. Additionally, you can now re-order the pages in the 

template or report by dragging and dropping the page thumbnails to change their order. The page 

thumbnails update dynamically when you interact with the template. 

 

To accommodate the new page navigation toolbar, the Tools toolbar has been relocated to the 

right, creating two tabs: (1) the Tools tab, and (2) the Format tab. The Format tab becomes 

visible when an item in the template or report is selected. 

Preferences 

• Case 52769 

New preferences are available to control the Library and Workflows directories scanned for 

templates, pages and scripts when REPORTER opens. By default, REPORTER will scan all of 

the directories listed. If you check 'Only this' in the Preferences dialog, REPORTER will scan 

only the specified Library or Workflows directory, and none of the directories above it (Library 

and Workflows are treated separately via reporter*library_only_use_specified_directory and 

oasys*workflow_only_use_specified_directory). This allows you to switch REPORTER to use a 

different directory when you customise the templates provided with the installation, or when you 

receive an updated bundle of templates from Oasys Ltd. 
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In addition, when REPORTER scans Library and Workflows directories for templates and pages, 

it now scans subdirectories recursively. The scripts directory is not scanned recursively. 

• Case 52153 

You can now set your preferred PDF and HTML applications through REPORTER's preferences 

dialog. These preferences will allow you to choose the application that will be launched when 

opening a PDF or HTML file from REPORTER. 

Properties 

• Case 45398 

D3PLOT items in REPORTER now have two extra options: (1) pre-blank the D3PLOT model 

before reading the properties file, and (2) ignore elements when reading the properties file. These 

options are originally preferences, and still are, but are now also per-item options. Since these 

options are now part of the report or template, using them will ensure similar captures when the 

report or template is shared with users that do not have the corresponding preferences set. If you 

open a version 21 and above template or report, the preferences are ignored and the per-item 

options are honoured. If you open a version 20.1 and below template or report, the preferences 

are only honoured as long as none of the two options are selected in the D3PLOT dialog. 

Python api 

• Case 52123 

To make the most out of the newly introduced Python API, REPORTER now allows you to 

create a gRPC server connection from both the command line via '-grpc' and from the Script 

menu. 
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3.5 SHELL 

Process 

• Case 51805 

In SHELL 21, a new input option NCSP has been introduced. The NCSP allows you to specify 

the number of processors that will be used for local model in a co-simulation. 
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3.6 Oasys 

JavaScript API 
• Case 43709 

The way that scripts, which use windows/ GUIs, are run has changed in Oasys Suite 21.0. Please 

see the ‘What’s new’ guide for details. 

Licensing 
• Case 51631 

After a licence is checked out initially, the LMX system periodically checks that there is still a 

valid connection with the licence server. If this is lost for more than 10 minutes, we tell you and 

kill the job. 

 

This was a ‘sudden death’ situation with no warning, and hence no opportunity to save work in 

progress. Therefore, it has been modified as follows: 

 

- If the connection to the server is lost for more than 5 minutes, a warning is issued explaining 

the problem and suggesting that work is saved. 

 

- If connection continues to be lost, this warning is repeated at 2 minute intervals until finally the 

termination time is reached. 

 

- At termination, we now perform an emergency keyout of all models in the database. On 

Windows, the MS-DOS controlling terminal window will also remain so that there is a record of 

what happened. 

Standard Templates 
• Case 38164 

Oasys Suite 21.0 features two new Workflow tools for seismic analysis: Seismic Storey Drift and 

Seismic Storey Force. These workflows help you process and report the calculation of storey 

drifts and section forces. Setup on one model in PRIMER and then process any number of 

ground motions in D3PLOT and T/HIS, and automate the workflows using the new Seismic 

REPORTER templates. 

User Interface 

• Case 52547 

When entities are screen-picked, the screen pick menu is auto-populated and gives you further 

information on the entities picked. This menu also includes options to refine picking and can be 

explicitly invoked by clicking ‘Vis’ in any object menu. 

The ‘Vis’ (screen pick) menu has been redesigned to make various options more accessible and 

intuitive. Buttons have been reorganised, icons introduced, and hover text added. 

This menu can now, optionally, be made a floating menu by setting the preference 

primer*vis_menu_position and giving it the value ‘FLOATING’ 
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Workflows 
• Case 52799 

Added LS-DYNA to the ISO-MME workflow tool as part of Virtual testing support which can 

export LS-DYNA entity data in ISO-MME format. 

• Case 52617 
This new Euro NCAP VTC Videos Workflow tool helps you calculate the views and export the 

videos as specified in section 5.2.1 of the Euro NCAP Virtual Far Side Simulation & Assessment 

Protocol. 

• Case 52347 
Added an extra ‘workflow_name’ argument to some of the Workflow API functions. 

 

In PRIMER: 

 

For Workflow.NumberOfModels() 

 

- If defined, it returns the number of models that have data for the specified workflow. 

- If not defined, it works as before where it returns the number of models that have data for the 

workflow selected in the workflows menu. 

 

 

For Workflow.ModelIdFromIndex() 

 

- If defined, it looks through the list of models that have data for the named workflow and returns 

the model ID of the model at the specified index in the list. 

- If not defined, it works as before where it returns the model ID of the model at the specified 

index in the list of models that have data for the workflow selected. 

 

 

In D3PLOT / T/HIS: 

 

For Workflow.WorkflowDefinitionFilename() 

 

- If defined, it returns the filename of the workflow definition filename for the specified 

workflow. 

- If not defined, it returns the workflow definition filename for the workflow in the workflows 

menu. 

 

For Workflow.NumberOfSelectedModels() 

 

- If defined, it returns the number of models that have data for the specified workflow (out of the 

models that were selected in the workflows menu). 

- If not defined, it works as before where it returns the number of models that were selected in 

the workflows menu. 

 

For Workflow.ModelIdFromIndex() 

 

- If defined, it looks through the list of models that have data for the named workflow out of the 
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models selected and returns the model ID of the model at the specified index in the list. 

- If not defined, it works as before where it returns the model ID of the model at the specified 

index in the list of models that were selected. 

• Case 51862 
In Oasys Suite 21.0, a new workflow tool for assessing the quality criteria specified in section 

6.1 of the Euro NCAP Virtual Far Side Simulation & Assessment Protocol v1.0 is now available 

as part of Virtual testing support. 

 




